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1

Product description

Category

Description

Product Name

HP 406 G1 Microtower Business Desktop PC

Processors Intel Core i7-4770 (3.4 GHz, 8 MB cache); Intel HD Graphics 4600
Intel Core i5-4570 (3.2 GHz, 6 MB cache); Intel HD Graphics 4600
Intel Core i3-4130 (3.4 GHz, 3 MB cache); Intel HD Graphics 4400
Intel Pentium Dual Core G3220 (3.0 GHz, 3 MB cache); Intel HD
Graphics

Chipset Intel Q85

Graphics Intel HD Graphics; varies by processor

Memory Four customer-accessible/upgradable memory module slots
1600MHz - 12800 DDR3, dual channel support
Supports up to 8 GB of system RAM integrated into the system board in the
following options:
e 8GB(4GBx2)
e 4GB(4GBx1)
e 2GB(2GBx1)

Hard drive Supports the following 3.5-inch, 6 Gb/s, SATA hard drives:

e 1.TB, 7200 rpm

e 500-GB, 7200 rpm

Optical drive

Supports the following 5.25-inch SATA optical drives:
e  SuperMulti DVD+RW
« DVDROM (8x)

Supports no optical drive option

Audio

Integrated high definition audio
Standard internal speaker

Internal amplifier - Realtek ALC221




Category Description

Ethernet 10/100/1000M GbE local area network (LAN) Realtek RTL8 111G

Internal expansion (1) 3.5-inch hard drive bay
(1) 2.5-inch hard drive/solid-state drive bay
(1) 5.25-inch optical drive bay
(1) PCle x1 slot
(1) PCle x16 slot

(1) PCI 2.3 slot

Ports Rear 10:
(4) USB 3.0 ports
(2) USB 2.0 ports
Audio out connector
Audio in connector
Microphone in connector
RJ-45 connector
VGA connector
PS/2 connector
Front 10:
2 USB 2.0 ports
Headphone connector

Microphone connector

Keyboard and mouse Universal USB wired Windows 8 keyboard
Universal USB wired optical mouse
HP PS/2 keyboard

HP PS/2 mouse

Power requirements Internal power supply unit
300W aPFC

300W EStar
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Category Description

Operating system Preinstalled:
Windows 8.1 downgrade to Windows 7
Windows 8.1 Professional 64 bit
Windows 7 Professional 64 bit
Ubuntu Linux CR 64 bit
Ubuntu Linux
SoftPaq
Windows 7 driver (64 bit)

Windows 8.1 driver (64 bit)

Serviceability End user replaceable part:
Hard drive
Optical drive

Memory




2 Product features

Front components

1 Hard Disk Drive Indicator Light 5 Optical drive activity light
2 Power Indicator Light 6 Microphone In Port
3 Power button 7 Audio Line Out Port
4 Optical Disk Drive Ejection Button 8 Two USB 2.0 Ports

4 Chapter 2 Product features



Rear components

0000 ©00 00

1 Power Cord Connector 7 Two (2) USB 3.0 Ports

2 Access Panel Screw 8 VGA Video Output Connection

3 Audio Line In Connector 9 PS/2 Mouse Connector (green)

4 Audio Line Out Connector 10 PS/2 Keyboard Connector (purple)
5 Microphone In Connector 11 RJ-45 Network Connection Port

6 Two (2) USB 3.0 Ports 12 Two (2) USB 2.0 Ports

Rear components
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3 Activating and Customizing the
Software

@NOTE: This chapter provides information for both Windows 7 and Windows 8.

Activating and customizing the software in
Windows 7

If your computer was not shipped with a Windows® operating system, some portions of this
documentation do not apply. Additional information is available in online help after you activate the
operating system.

/\ CAUTION: Do not add optional hardware or third-party devices to the computer until the operating
system is successfully activated. Doing so may cause errors and prevent the operating system from
installing properly.

2¥»NOTE: Be sure there is a 10.2 cm (4 inch) clearance at the back of the unit and above the monitor to
permit the required airflow.

Activating the Windows operating system

The first time you turn on the computer, the operating system is set up and activated automatically. This
process takes about 5 to 10 minutes. Carefully read and follow the instructions on the screen to
complete the activation.

We recommend that you register your computer with HP during operating system setup so you can
receive important software updates, facilitate support questions, and sign up for special offers.

/\ CAUTION: After the activation process has begun, DO NOT TURN OFF THE COMPUTER UNTIL THE
PROCESS IS COMPLETE. Turning off the computer during the activation process may damage the
software that runs the computer or prevent its proper installation.

E/%"NOTE: If the computer shipped with more than one operating system language on the hard drive, the
activation process could take up to 60 minutes.

Chapter 3 Activating and Customizing the Software



Downloading Windows 7 updates

Microsoft may release updates to the operating system. To help keep the computer running optimally,
HP recommends checking for the latest updates during the initial installation and periodically
throughout the life of the computer.

1. To set up your Internet connection, click Start > Internet Explorer and follow the instructions
on the screen.

2. After an Internet connection has been established, click the Start > All Programs > Windows
Update.

3. Run Windows Update monthly thereafter.

Installing or upgrading device drivers

When installing optional hardware devices after the operating system installation is complete, you must
also install the drivers for each of the devices.

In Windows 7, if prompted for the i386 directory, replace the path specification with C:\ 1386, or use
the Browse button in the dialog box to locate the 1386 folder. This action points the operating system
to the appropriate drivers.

Obtain the latest support software, including support software for the operating system, from
http://www.hp.com/support. Select your country and language, select Download drivers and
software (and firmware), enter the model number of the computer, and press Enter.

Customizing the monitor display

If you wish, you can select or change the monitor refresh rates, screen resolution, color settings, font
sizes, and power management settings.

For more information, refer to the online documentation provided with the graphics controller utility or
the documentation that came with your monitor.

Right-click on the Windows desktop, then click Personalize to change display settings.

Activating and customizing the software in
Windows 8

Additional information is available in online help after you activate the operating system.

2 NOTE: Be sure there is a 10.2 cm (4 inch) clearance at the back of the unit and above the monitor to
permit the required airflow.

Activating the Windows Operating System
The first time you turn on the computer, the operating system is set up and activated automatically. This

process takes about 5 to 10 minutes. Carefully read and follow the instructions on the screen to
complete the activation.

Activating and customizing the software in Windows 8
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We recommend that you register your computer with HP during operating system set up so you can
receive important software updates, facilitate support questions, and sign up for special offers. You can
also register your computer with HP using the Register with HP app on the Start screen.

/\ CAUTION: After the activation process has begun, DO NOT TURN OFF THE COMPUTER UNTIL THE

PROCESS IS COMPLETE. Turning off the computer during the activation process may damage the
software that runs the computer or prevent its proper installation.

Downloading Windows 8 updates

Microsoft may release updates to the operating system. To help keep the computer running optimally,
HP recommends checking for the latest updates during the initial installation and periodically
throughout the life of the computer.

Run Windows Update as soon as possible after you set up your computer.
1. Point to the upper-right or lower-right corner of the Start screen to display the charms.
2. Click Settings > Change PC Settings > Windows Update.

3. Run Windows Update monthly thereafter.

Customizing the monitor display

You can customize display settings for Windows 8 separately for the Start screen and the Desktop.
To customize the Start screen:

1. Point o the upper-right or lower-right corner of the Start screen to display the charms.

2. Click Settings > Change PC Settings.

3. Click Personalize to change the display settings.

To customize the Desktop:

1. Click the Desktop app on the Start screen.

2. Rightclick on the desktop, and then click Personalize to change display settings.

Chapter 3 Activating and Customizing the Software



4 lllustrated parts catalog

This chapter provides spare part information for all chassis.

2 NOTE: HP continually improves and changes product parts. For complete and current information on
supported parts for your computer, go to http://partsurfer.hp.com, select your country or region, and
then follow the on-screen instructions.

Computer Major Components

Computer Major Components


http://partsurfer.hp.com

ltem Description

Spare part number

(1) Access panel 787797-001
(2) Front bezel 787795-001
(3) Power supply, 300W
300W, EStar 712298-001
300W, for use only in India and Southeast Asia 689005-001
(4) System board (includes replacement thermal material)
For use in non-Windows 8 models 787304-001
For use in models with Windows 8 Standard 787304-501
For use in models with Windows 8 Professional 787304-601
Memory modules, PC3-12800, 1666-MHz (not illustrated)
8-GB 689375-001
4-GB 671613-001
2-GB 671612-001
Processors (include replacement thermal material; not illustrated)
Intel Core i7-4770, 3.4 GHz, 8-MB L3 cache, 86W 727373-001
Intel Core i5-4570, 3.2 GHz, 6-MB L3 cache, 86W 727380-001
Intel Core i3-4130, 3.4 GHz, 3-MB L3 cache, 54W 742560-001
Intel Pentium G3220, 3.0 GHz, 3-MB L3 cache, 54W 742564-001
Intel Celeron G1810, 2.7 GHz, 2-MB L3 cache, 54W 758756-001

Drives

Description

Spare part number

Hard drive

1-TB, 7200-rpm 667719-001
500-GB, 7200-rpm 667720-001
Optical drive

DVD-ROM drive 581599-001
SuperMulti DVD+RW drive 690418-001
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Misc Parts

Item Description Spare part number

(1) Fan sink (includes replacement thermal material) 667727001

(2) Front 1/0 and USB assembly 787798-001

(3) Speaker 751593-001

(4) System fan 657103-001
Foot, rubber 530593-001
Keyboards
USB, unbranded, English 709695-131
USB, HP Essential, for use in Taiwan 729339-AB1
USB, HP Essential, for use in Thailand 729339-281
PS/2 for use in India 724718-D61
PS/2 for use in Taiwan 724718-AB1
PS/2 for use in Thailand 724718-281
PS/2 for use in the United States 724718-001
Mouse (optical, USB; not illustrated)
PS/2 674315-001
UsB 719901-001

Misc Parts
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Cables

ltem Description

Spare part number

(1) Power switch/LED assembly

787796-001

(2) SATA cable, 254 mm, 2 straight ends

660147-001

Sequential Part Number Listing

Spare part  Description

number

530593-001  Foot, rubber

581599-001  DVD-ROM drive

657103001  System fan

660147-001  SATA cable, 254 mm, 2 straight ends
667719001 1 TB, 7200-rpm hard drive

667720001 500 GB, 7200-rpm hard drive

667727001  Fan sink

671612001  2-GB memory module, PC3-12800, 1666-MHz
671613001  4-GB memory module, PC3-12800, 1666-MHz
674315001  Mouse, PS/2

689005-001  Power supply, 300W, for use only in India and Southeast Asia
689375001  8-GB memory module, PC3-12800, 1666-MHz
690418-001  SuperMulti DVD+RW drive

12 Chapter 4 lllustrated parts catalog



Spare part  Description

number

692096-001  Power supply, 300W

709695-131 Keyboard, unbranded, English

712298001  Power supply, 300W, EStar

719901-001 Mouse, USB

724718001  Keyboard, PS/2, for use in the United States

724718281  Keyboard, PS/2, for use in Thailand

724718-AB1  Keyboard, PS/2, for use in Taiwan

724718D61  Keyboard, PS/2, for use in India

727373001  Intel Core i7 4770, 3.4 GHz, 8-MB L3 cache, 86W

727380-001 Intel Core i5-4570 processor, 3.2 GHz, 6-MB L3 cache, 86W

729339281  Keyboard, USB, HP Essential, for use in Thailand

729339-AB1  Keyboard, USB, HP Essential, for use in Taiwan

742561001  Intel Core i3-4130 processor, 3.4 GHz, 3-MB L3 cache, 54W

742564-001  Intel Pentium G3220 processor, 3.0 GHz, 3-MB L3 cache, 54W

751593-001  Speaker

758756-001  Intel Celeron G1810 (2.7 GHz, 2-MB L3 cache, 54W)

787304-001  System board for use in non-Windows 8 models (includes replacement thermal material)
787304-501  System board for use in models with Windows 8 Standard (includes replacement thermal material)
787304-601  System board for use in models with Windows 8 Professional (includes thermal material)
787795001  Front bezel

787796001  Power switch/LED assembly with cable

787797001  Access panel

787798-001 Front I/O and USB assembly

Sequential Part Number Listing

13



5 Rovutine care, SATA drive

guidelines, and disassembly
preparation

This chapter provides general service information for the computer. Adherence to the procedures and
precautions described in this chapter is essential for proper service.

/\ CAUTION: When the computer is plugged into an AC power source, voltage is always applied to
the system board. You must disconnect the power cord from the power source before opening the
computer fo prevent system board or component damage.

Electrostatic discharge information

A sudden discharge of static electricity from your finger or other conductor can destroy static-sensitive
devices or microcircuitry. Often the spark is neither felt nor heard, but damage occurs. An electronic
device exposed to electrostatic discharge (ESD) may not appear to be affected at all and can work
perfectly throughout a normal cycle. The device may function normally for a while, but it has been
degraded in the internal layers, reducing its life expectancy.

Networks built into many integrated circuits provide some protection, but in many cases, the discharge
contains enough power to alter device parameters or melt silicon junctions.

14 Chapter 5 Routine care, SATA drive guidelines, and disassembly preparation



Generating static

The following table shows that:

o Different activities generate different amounts of static electricity.
e Static electricity increases as humidity decreases.
Relative Humidity
Event 55% 40% 10%
Walking across carpet 7,500 V 15,000 V 35,000 V
Walking across vinyl floor 3,000V 5,000 V 12,000 V
Motions of bench worker 400V 800V 6,000V
Removing DIPs from plastic tube 400 V 700V 2,000 V
Removing DIPs from vinyl tray 2,000 V 4,000V 11,500 V
Removing DIPs from Styrofoam 3,500 V 5,000 V 14,500 V
Removing bubble pack from PCB 7,000 V 20,000 V 26,500 V
Packing PCBs in foam-lined box 5,000 V 11,000 V 21,000 V

These are then multi-packaged inside plastic tubes, trays, or Styrofoam.

[y NOTE: 700 volts can degrade a product.

Preventing electrostatic damage to equipment

Many electronic components are sensitive to ESD. Circuitry design and structure determine the degree
of sensitivity. The following packaging and grounding precautions are necessary to prevent damage to
electric components and accessories.

To avoid hand contact, transport products in static-safe containers such as tubes, bags, or boxes.

Protect all electrostatic parts and assemblies with conductive or approved containers or
packaging.

Keep electrostatic sensitive parts in their containers until they arrive at static-free stations.
Place items on a grounded surface before removing them from their container.

Always be properly grounded when touching a sensitive component or assembly.

Avoid contact with pins, leads, or circuitry.

Place reusable electrostatic-sensitive parts from assemblies in protective packaging or conductive
foam.

Electrostatic discharge information
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Personal grounding methods and equipment

Use the following equipment to prevent static electricity damage to equipment:

e  Wrist straps are flexible straps with a maximum of one-megohm + 10% resistance in the ground
cords. To provide proper ground, a strap must be worn snug against bare skin. The ground cord
must be connected and fit snugly into the banana plug connector on the grounding mat or
workstation.

e Heel straps/Toe straps/Boot straps can be used at standing workstations and are
compatible with most types of shoes or boots. On conductive floors or dissipative floor mats, use
them on both feet with a maximum of one-megohm + 10% resistance between the operator and

ground.
Static Shielding Protection Levels
Method Voltage
Antistatic plastic 1,500
Carbon-loaded plastic 7,500
Metallized laminate 15,000

Grounding the work area

To prevent static damage at the work areq, use the following precautions:

e  Cover the work surface with approved static-dissipative material. Provide a wrist strap connected
to the work surface and properly grounded tools and equipment.

e  Use static-dissipative mats, foot straps, or air ionizers to give added protection.

e Handle electrostatic sensitive components, parts, and assemblies by the case or PCB laminate.
Handle them only at staticfree work areas.

e Turn off power and input signals before inserting and removing connectors or test equipment.
e  Use fixtures made of static-safe materials when fixtures must directly contact dissipative surfaces.

o Keep work area free of nonconductive materials such as ordinary plastic assembly aids and
Styrofoam.

e Use field service tools, such as cutters, screwdrivers, and vacuums, that are conductive.

Recommended materials and equipment
Materials and equipment that are recommended for use in preventing static electricity include:
e Antistatic tape
e Antistatic smocks, aprons, or sleeve protectors

e  Conductive bins and other assembly or soldering aids
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Conductive foam

Conductive tabletop workstations with ground cord of one-megohm +/- 10% resistance
Static-dissipative table or floor mats with hard tie to ground

Field service kits

Static awareness labels

Wrist straps and footwear straps providing one-megohm +/- 10% resistance
Material handling packages

Conductive plastic bags

Conductive plastic tubes

Conductive tote boxes

Opagque shielding bags

Transparent metallized shielding bags

Transparent shielding tubes

Operating guidelines

To prevent overheating and to help prolong the life of the computer:

Keep the computer away from excessive moisture, direct sunlight, and extremes of heat and cold.

Operate the computer on a sturdy, level surface. Leave a 10.2-cm (4-inch) clearance on all vented
sides of the computer and above the monitor to permit the required airflow.

Never restrict the airflow into the computer by blocking any vents or air intakes. Do not place the
keyboard, with the keyboard feet down, directly against the front of the desktop unit as this also
restricts airflow.

Occasionally clean the air vents on all vented sides of the computer. Lint, dust, and other foreign
matter can block the vents and limit the airflow. Be sure to unplug the computer before cleaning
the air vents.

Never operate the computer with the cover or side panel removed.

Do not stack computers on top of each other or place computers so near each other that they are
subject to each other’s re-circulated or preheated air.

If the computer is to be operated within a separate enclosure, intake and exhaust ventilation must
be provided on the enclosure, and the same operating guidelines listed above will still apply.

Keep liquids away from the computer and keyboard.
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e  Never cover the ventilation slots on the monitor with any type of material.

e Install or enable power management functions of the operating system or other software, including
sleep states.

Routine care

General cleaning safety precautions
1. Never use solvents or flammable solutions to clean the computer.

2. Never immerse any parts in water or cleaning solutions; apply any liquids to a clean cloth and
then use the cloth on the component.

Always unplug the computer when cleaning with liquids or damp cloths.

3
4. Always unplug the computer before cleaning the keyboard, mouse, or air vents.
5. Disconnect the keyboard before cleaning it.

6

Wear safety glasses equipped with side shields when cleaning the keyboard.

Cleaning the Computer Case

Follow all safety precautions in General cleaning safety precautions on page 18 before cleaning the
computer.

To clean the computer case, follow the procedures described below:
e To remove light stains or dirt, use plain water with a clean, lintfree cloth or swab.

e  For stronger stains, use a mild dishwashing liquid diluted with water. Rinse well by wiping it with
a cloth or swab dampened with clear water.

e  For stubborn stains, use isopropyl (rubbing) alcohol. No rinsing is needed as the alcohol will
evaporate quickly and not leave a residue.

e  Atfter cleaning, always wipe the unit with a clean, lintfree cloth.
e  Occasionally clean the air vents on the computer. Lint and other foreign matter can block the vents
and limit the airflow.

Cleaning the keyboard

Follow all safety precautions in General cleaning safety precautions on page 18 before cleaning the
keyboard.

To clean the tops of the keys or the keyboard body, follow the procedures described in Cleaning the
Computer Case on page 18.

When cleaning debris from under the keys, review all rules in General cleaning safety precautions
on page 18 before following these procedures:
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/\ CAUTION: Use safety glasses equipped with side shields before attempting to clean debris from
under the keys.

e Visible debris underneath or between the keys may be removed by vacuuming or shaking.

e Canned, pressurized air may be used to clean debris from under the keys. Caution should be used
as too much air pressure can dislodge lubricants applied under the wide keys.

e If you remove a key, use a specially designed key puller to prevent damage to the keys. This tool
is available through many electronic supply outlets.

/\ CAUTION: Never remove a wide leveled key (like the space bar) from the keyboard. If these
keys are improperly removed or installed, the keyboard may not function properly.

e Cleaning under a key may be done with a swab moistened with isopropyl alcohol and squeezed
out. Be careful not to wipe away lubricants necessary for proper key functions. Use tweezers to
remove any fibers or dirt in confined areas. Allow the parts to air dry before reassembly.

Cleaning the monitor

e  Wipe the monitor screen with a clean cloth moistened with water or with a towelette designed for
cleaning monitors. Do not use sprays or aerosols directly on the screen; the liquid may seep into
the housing and damage a component. Never use solvents or flammable liquids on the monitor.

e To clean the monitor body follow the procedures in Cleaning the Computer Case on page 18.

Cleaning the mouse

Before cleaning the mouse, ensure that the power to the computer is turned off.

e  Clean the mouse ball by first removing the retaining plate and the ball from the housing. Pull out
any debris from the ball socket and wipe the ball with a clean, dry cloth before reassembly.

e To clean the mouse body, follow the procedures in Cleaning the Computer Case on page 18.

Service considerations

Listed below are some of the considerations that you should keep in mind during the disassembly and
assembly of the computer.

Power supply fan

The power supply fan is a variable-speed fan based on the temperature in the power supply.

/\ CAUTION: The cooling fan is always on when the computer is in the “On” mode. The cooling fan is
off when the computer is in “Standby,” “Suspend,” or “Off” modes.

You must disconnect the power cord from the power source before opening the computer to prevent
system board or component damage.
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Tools and software Requirements

To service the computer, you need the following:

Screws

Torx T-15 screwdriver

Torx T-15 screwdriver with small diameter shank (for certain front bezel removal)
Flat-bladed screwdriver (may sometimes be used in place of the Torx screwdriver)
Phillips #2 screwdriver

Diagnostics software

Tamper-resistant T-15 wrench

The screws used in the computer are not interchangeable. They may have standard or metric threads
and may be of different lengths. If an incorrect screw is used during the reassembly process, it can
damage the unit. HP strongly recommends that all screws removed during disassembly be kept with the
part that was removed, then returned to their proper locations.

/\ CAUTION: Metric screws have a black finish. U.S. screws have a silver finish and are used on hard
drives only.

CAUTION: As each subassembly is removed from the computer, it should be placed away from the
work area to prevent damage.

Cables and connectors

Most cables used throughout the unit are flat, flexible cables. These cables must be handled with care
to avoid damage. Apply only the tension required to seat or unseat the cables during insertion or
removal from the connector. Handle cables by the connector whenever possible. In all cases, avoid
bending or twisting the cables, and ensure that the cables are routed in such a way that they cannot be
caught or snagged by parts being removed or replaced.

/\ CAUTION: When servicing this computer, ensure that cables are placed in their proper location
during the reassembly process. Improper cable placement can damage the computer.

Hard Drives

Handle hard drives as delicate, precision components, avoiding all physical shock and vibration. This
applies to failed drives as well as replacement spares.

If a drive must be mailed, place the drive in a bubble-pack mailer or other suitable protective
packaging and label the package “Fragile: Handle With Care.”

Do not remove hard drives from the shipping package for storage. Keep hard drives in their
protective packaging until they are actually mounted in the CPU.

Avoid dropping drives from any height onto any surface.
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e If you are inserting or removing a hard drive, turn off the computer. Do not remove a hard drive
while the computer is on or in standby mode.

e Before handling a drive, ensure that you are discharged of static electricity. While handling a
drive, avoid touching the connector.

e Do not use excessive force when inserting a drive.

e  Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic
fields such as monitors or speakers.

SATA hard drives

Serial ATA Hard Drive Characteristics

Number of pins/conductors in data cable 7/7

Number of pins in power cable 15

Maximum data cable length 39.37in (100 cm)
Data inferface voltage differential 400-700 mV
Drive voltages 3.3V,5V,12V
Jumpers for configuring drive N/A

Data transfer rate 6.0 Gb/s

SATA hard drive cables

SATA data cable

Always use an HP approved SATA 3.0 Gb/s cable as it is fully backwards compatible with the SATA
1.5 Gb/s drives.

Current HP desktop products ship with SATA 3.0 Gb/s hard drives.

SATA data cables are susceptible to damage if overflexed. Never crease a SATA data cable and never
bend it tighter than a 30 mm (1.18 in) radius.

The SATA data cable is a thin, 7-pin cable designed to transmit data for only a single drive.

SMART ATA drives

The Self Monitoring Analysis and Recording Technology (SMART) ATA drives for the HP Personal
Computers have built-in drive failure prediction that warns the user or network administrator of an
impending failure or crash of the hard drive. The SMART drive tracks fault prediction and failure
indication parameters such as reallocated sector count, spin retry count, and calibration retry count. If
the drive determines that a failure is imminent, it generates a fault alert.
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Cable management

22

Always follow good cable management practices when working inside the computer.

Keep cables away from major heat sources like the heat sink.

Do not jam cables on top of expansion cards or memory modules. Printed circuit cards like these
are not designed to take excessive pressure on them.

Keep cables clear of sliding or moveable parts to prevent them from being cut or crimped when
the parts are moved.

When folding a flat ribbon cable, never fold to a sharp crease. Sharp creases may damage the
wires.

Some flat ribbon cables come prefolded. Never change the folds on these cables.
Do not bend any cable sharply. A sharp bend can break the internal wires.
Never bend a SATA data cable tighter than a 30 mm (1.18 in) radius.

Never crease a SATA data cable.

Do not rely on components like the drive cage, power supply, or computer cover to push cables
down into the chassis. Always position the cables to lay properly by themselves.
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6 Removal and replacement
procedures

E‘%NOTE: HP continually improves and changes product parts. For complete and current information on
supported parts for your computer, go to http://partsurfer.hp.com, select your country or region, and
then follow the on-screen instructions.

Adherence to the procedures and precautions described in this chapter is essential for proper service.
After completing all necessary removal and replacement procedures, run the Diagnostics utility to verify
that all components operate properly.

%}?NOTE: Not all features listed in this guide are available on all computers.

Serviceability features

The computers include features that make them easy to upgrade and service. A Torx T-15, Phillips, or
flat blade screwdriver is needed for many of the installation procedures described in this guide.

Preparation for disassembly

1. Close any open software applications.

2. Exit the operating system.

3. Remove any diskette or compact disc from the computer.
4

Turn off the computer and any peripheral devices that are connected o it.

/A CAUTION: Turn off the computer before disconnecting any cables.

CAUTION: Regardless of the power-on state, voltage is always present on the system board as
long as the system is plugged into an active AC outlet. In some systems the cooling fan is on even
when the computer is in the “Standby,” or “Suspend” modes. The power cord should always be
disconnected before servicing a unit.
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5. Disconnect the power cord from the electrical outlet and then from the computer.

6. Disconnect all peripheral device cables from the computer.

E/?NOTE: During disassembly, label each cable as you remove it, noting its position and routing.
Keep all screws with the units removed.

/\ CAUTION: The screws used in the computer are of different thread sizes and lengths; using the
wrong screw in an application may damage the unit.

Access panel

Description Spare part number

Access panel 787797-001

1. Prepare the computer for disassembly (Preparation for disassembly on page 23).

2. Loosen the captive Torx screw (1) on the back panel that secures the panel to the computer.

3. Slide the side panel toward the back (2), and then pull it away from the computer.

E’%NOTE: Lay the computer on its side to install internal parts.

To replace the access panel, reverse the removal steps.
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Front bezel

Description Spare part number

Front bezel 787795-001

1. Prepare the computer for disassembly (Preparation for disassembly on page 23).

Remove the access panel (Access panel on page 24).

Press outward on the three latches (1) on the right side of the bezel.

Lol S

Rotate the right side of the bezel off the chassis, and then remove the bezel from the chassis (2).

To reinstall the front bezel, reverse the removal procedure.
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Memory

Description Spare part number
Memory module, 8-GB 689375001
Memory module, 4-GB 671613-001
Memory module, 2-GB 671612001

The computer comes with double data rate 3 synchronous dynamic random access memory (DDR3-
SDRAM) dual inline memory modules (DIMMs).

DDR3/DDR3L-SDRAM UDIMMs or SODIMMs

26

The system board offers four memory sockets.

The memory sockets on the system board can be populated with up to four industry-standard DIMMs.
These memory sockets are populated with at least one preinstalled DIMM. To achieve the maximum
memory support, you can populate the system board with up to 8 GB of memory configured in a high
performing dual channel mode.

For proper system operation, the DDR3/DDR3L UDIMMs or SODIMMs must be:
e industry-standard 240-pin

e unbuffered non-ECC PC3-12800 DDR3L-1600 MHz-compliant

e 1.5 volt DDR3/DDR3L

The DDR3/DDR3L UDIMMs or SODIMMs must also:

e support CAS latency 9 DDR3 1600 MHz (11-11-11 fiming)

e  contain the mandatory JEDEC SPD information

In addition, the computer supports:

e 512-Mbit, 1-Gbit, 2-Gbit, and 4-Gbit non-ECC memory technologies

e singlessided and double-sided DIMMs

e UDIMMs or SODIMMs constructed with x8 and x16 DDR devices; UDIMMs constructed with x4
SDRAM are not supported

@NOTE: The system will not operate properly if you install unsupported DIMMs.
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Populating DIMM sockets

There are four DIMM sockets on the system board, with two sockets per channel. The sockets are
labeled DIMM1, DIMM2, DIMM3, and DIMM4. Sockets DIMM1 and DIMM2 operate in memory
channel B. Sockets DIMM3 and DIMM4 operate in memory channel A.

DiMM1
DiMMm2

DiMmM3
DiMm4

Description Socket Color Insertion Order
DIMM1 socket, Channel A (populate first) Black 1
DIMM?2 socket, Channel A Blue 2
DIMM3 socket, Channel B Black 3
DIMM4 socket, Channel B Blue 4

NOTE: A memory module must occupy the DIMM1/Channel A socket.

The system will automatically operate in single channel mode, dual channel mode, or flex mode,
depending on how the DIMMs are installed.

Memory
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2 NOTE: Single channel and unbalanced dual channel memory configurations will result in inferior

graphics performance.

e  The system will operate in single channel mode if the DIMM sockets are populated in one channel
only.

e  The system will operate in a higher-performing dual channel mode if the total memory capacity of
the DIMMs in Channel A is equal to the total memory capacity of the DIMMs in Channel B. The
technology and device width can vary between the channels. For example, it Channel A is
populated with one 2-GB DIMM and Channel B is populated with one 4-GB DIMM, the system will
operate in dual channel mode.

e  The system will operate in flex mode if the total memory capacity of the DIMMs in Channel A is
not equal to the total memory capacity of the DIMMs in Channel B. In flex mode, the channel
populated with the least amount of memory describes the total amount of memory assigned to dual
channel and the remainder is assigned to single channel. For optimal speed, the channels should
be balanced so that the largest amount of memory is spread between the two channels. If one
channel will have more memory than the other, the larger amount should be assigned to Channel
A. For example, if you are populating the sockets with one 4-GB DIMM, and one 2-GB DIMM,
Channel A should be populated with the 4-GB DIMM, and Channel B should be populated with
the 2-GB DIMM. With this configuration, 4 GB will run as dual channel and 2 GB will run as
single channel.

e Inany mode, the maximum operational speed is determined by the slowest DIMM in the system.

The system will automatically operate in single channel mode, dual channel mode, or flex mode,
depending on how the DIMMs are installed.

Removing memory modules
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/\ CAUTION: You must disconnect the power cord and wait approximately 30 seconds for the power

to drain before adding or removing memory modules. Regardless of the power-on state, voltage is
always supplied to the memory modules as long as the computer is plugged into an active AC outlet.
Adding or removing memory modules while voltage is present may cause irreparable damage to the
memory modules or system board.

The memory module sockets have gold-plated metal contacts. When upgrading the memory, it is
important to use memory modules with gold-plated metal contacts to prevent corrosion and/or
oxidation resulting from having incompatible metals in contact with each other.

Static electricity can damage the electronic components of the computer or optional cards. Before
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a
grounded metal object.

When handling a memory module, be careful not to touch any of the contacts. Doing so may damage
the module.

1. Prepare the computer for disassembly (Preparation for disassembly on page 23).

2. Remove the access panel (Access panel on page 24).
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3. Locate the memory module sockets on the system board.

/A WARNING! To reduce risk of personal injury from hot surfaces, allow the internal system
components to cool before touching.

4. Open both latches (1) of the memory module socket , and remove the memory module from the
socket (2).

-~
o

©
-
o

To install @ memory module, reverse the removal procedures.

r__f%NOTE: A memory module can be installed in only one way. Match the notch on the module with the
tab on the memory socket.

A DIMM must occupy the XMM1 socket.

To create a dual-channel memory configuration, the memory capacity of Channel A must equal the
memory capacity of Channel B.

Cable management

Always follow good cable management practices when working inside the computer.
o Keep cables away from major heat sources like the heat sink.

e Do not jam cables on top of expansion cards or memory modules. Printed circuit cards like these
are not designed to take excessive pressure on them.

e  Some flat ribbon cables come prefolded. Never change the folds on these cables.
e Never bend a SATA data cable tighter than a 30 mm (1.18 in) radius.
e  Never crease a SATA data cable.

e Do not rely on components like the drive cage, power supply, or computer cover to push cables
down into the chassis. Always position the cables to lay properly by themselves.
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When removing the power supply power cable from the ATX_PWR connector on the system board,
always follow these steps:

1. Squeeze on the top of the retaining latch attached to the cable end of the connector (1).

2. Grasp the cable end of the connector and pull it straight up (2).

/\ CAUTION: Always pull the connector - NEVER pull on the cable. Pulling on the cable could
damage the cable and result in a failed power supply.

Cable connections

System board connectors are color-coded to make it easier to find the proper connection.

Connector Name Connector Color Description
ATX_POWER white Power supply, 24-pin
ATX_CPU white Power supply, 4-pin
CPU_FAN white Heat sink fan
INT_SPKR white Speaker

F_PANEL black Power switch
F_AUDIO yellow Front I/O audio
F_USB1 white Front I/O USB
SATAO dark blue Primary hard drive
SATAI white Primary optical drive
SATA2 light blue Secondary hard drive
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Expansion cards

The computer has one PCl Express x1 slot.

PCIE PCIE
PCI X1 X16

To remove an expansion card:

1. Prepare the computer for disassembly (Preparation for disassembly on page 23).

2. Remove the access panel (Access panel on page 24)
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3. Remove the screw that holds down the expansion card retention latch (1) then slide the latch up
(2) and pull it off the rear of the chassis (3).

4. Llocate the correct vacant expansion socket on the system board and the corresponding expansion
slot on the back of the computer chassis.

5. Before installing an expansion card, remove the expansion slot cover or the existing expansion
card.

2»NOTE: Before removing an installed expansion card, disconnect any cables that may be
attached to the expansion card.

a. |If you are installing an expansion card in a vacant socket, you must use a flatblade
screwdriver to pry out one of the metal shields on the rear panel that covers the expansion
slot. Be sure to remove the appropriate shield for the expansion card you are installing.
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b. If you are removing a PCl Express x1 card, hold the card at each end and carefully rock it
back and forth until the connectors pull free from the socket. Lift the card straight up then
away from the inside of the chassis to remove it. Be sure not to scrape the card against other

components.

c. If you are removing a PCl Express x16 card, pull the retention arm on the back of the
expansion socket away from the card and carefully rock the card back and forth until the
connectors pull free from the socket. Lift the card straight up to remove it. Be sure not to
scrape the card against other components.

6. Store the removed card in anti-static packaging.

7. If you are not installing a new expansion card, install an expansion slot cover to close the open
slot.

/\ CAUTION: After removing an expansion card, you must replace it with a new card or
expansion slot cover for proper cooling of internal components during operation.

To install an expansion card, reverse the removal procedures.

Expansion cards
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Connect external cables to the installed card, if needed. Connect internal cables to the system board, if

needed.
(]
Drives
Description Spare part number
SuperMulti DVD+RW drive 690418-001
DVD-ROM drive 581599-001
1 TB, 7200-rpm hard drive 667719001
500 GB, 7200-rpm hard drive for use in all models 667720-001

The computer supports up to three drives that may be installed in various configurations.

Item Description

1 Optical drive

2 Secondary 2.5-inch hard drive
3 Primary 3.5-inch hard drive

This section describes the procedure for replacing or upgrading the storage drives. A Torx T-15
screwdriver is needed to remove and install the guide screws on a drive.
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Installing additional drives

When installing drives, follow these guidelines:

e  The primary Serial ATA (SATA) hard drive must be connected to the dark blue primary SATA
connector on the system board labeled SATAO.

e  Connect an optical drive to the light blue SATA connector on the system board labeled SATA2.
e  Connect a secondary hard drive to white SATA connector labeled SATAT1.

e The power cables for the SATA drives connect directly to the power supply.

/\ CAUTION: To prevent loss of work and damage to the computer or drive:

If you are inserting or removing a drive, shut down the operating system properly, turn off the
computer, and unplug the power cord. Do not remove a drive while the computer is on or in standby
mode.

Before handling a drive, ensure that you are discharged of static electricity. While handling a drive,
avoid touching the connector. For more information about preventing electrostatic damage, refer to
Electrostatic discharge information on page 14.

Handle a drive carefully; do not drop it.
Do not use excessive force when inserting a drive.

Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic fields
such as monitors or speakers.

If a drive must be mailed, place the drive in a bubble-pack mailer or other protective packaging and
label the package “Fragile: Handle With Care.”
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System board drive connections

Refer to the following illustration and table to identify the system board drive connectors.

System Board Drive Connections

Drive System Board Label Color
Primary hard drive SATAO dark blue
Secondary hard drive SATAI white
Optical drive SATA2 light blue
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Removing an optical drive

/A CAUTION:  All removable media should be taken out of a drive before removing the drive from the
computer.

To remove an optical drive:

1. Prepare the computer for disassembly (Preparation for disassembly on page 23).

Remove the access panel (Access panel on page 24).

Remove the front bezel (Front bezel on page 25).

Disconnect the power and data cables (1) from the rear of the optical drive.

Remove the two Torx screws (2) that secure the drive to the computer.

L N T o

Slide the drive out of the computer (3).

To install an optical drive, reverse the removal procedures.
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Removing a hard drive

@NOTE: Before you remove the old hard drive, be sure to back up the data from the old hard drive so
that you can transfer the data to the new hard drive. Also, if you are replacing the primary hard drive,
make sure you have created a Recovery Disc Set fo restore the operating system, software drivers, and
any software applications that were preinstalled on the computer.

1. Prepare the computer for disassembly (Preparation for disassembly on page 23).

Remove the access panel (Access panel on page 24).

2

3. Disconnect the power and data cables (1) from the rear of the hard drive.
4. Remove the four Torx screws (2) that secure the drive to the computer.

5

Slide the hard drive toward the bottom of the computer (3), and then remove it from the
computer..

To install a hard drive, reverse the removal procedures.
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Front 1/0 and USB panel housing assembly

Description Spare part number
Front 1/O and USB assembly 787798001
1. Prepare the computer for disassembly (Preparation for disassembly on page 23).

I S

Remove the access panel (Access panel on page 24)

Lay the computer on its side with the front facing foward you.

Remove the front bezel (Front bezel on page 25).

Remove the cables from the metal clip built into the bottom of the chassis, and then unplug the two
cables from the yellow F_AUDIO and white F_USB1 connectors.

Front I/O and USB panel housing assembly
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6. Push in on the lever labeled ‘PUSH’.

7. Pull the assembly outward away from the front of the chassis while guiding the cables through the
hole in the chassis.

To install the housing assembly, reverse the removal procedures.
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Power switch/LED assembly

Description

Spare part number

Power switch/LED assembly 787796-001

S A

Prepare the computer for disassembly (Preparation for disassembly on page 23).

Remove the access panel (Access panel on page 24).

Remove the front bezel (Front bezel on page 25).

Remove the optical drive (Removing an optical drive on page 37).

Disconnect the braided cables from the black system board connector labeled F_PANEL.

Power switch/LED assembly
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6. Remove the cable from the metal clip built into the computer in the optical drive bay.
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7. From the outside of the computer, push the tab on the bottom of the assembly (1) to disengage it
from the computer, and then rotate the assembly upward (2), and pull it away from the computer
while threading the cable through the front of the chassis.

To install the power switch/LED assembly, reverse the removal procedures.

Power switch/LED assembly
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System fan

Description Spare part number

System fan 657103001

1. Prepare the computer for disassembly (Preparation for disassembly on page 23).

Remove the access panel (Access panel on page 24).

Remove the front bezel (Front bezel on page 25).

Remove the optical drive (Removing an optical drive on page 37).

LA

From the back of the computer, remove the four Phillips screws that secure the fan to the inside of
the computer.
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6. From the inside of the computer, disconnect the cable from the red system board connector
labeled SYS_FAN (1), and the remove the fan from the computer (2).

To install the system fan, reverse the removal procedures.
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Speaker

Description Spare part number

Speaker 751593-001

The speaker is attached to the front of the chassis under the rotating drive cage.

1. Prepare the computer for disassembly (Preparation for disassembly on page 23).

Remove the access panel (Access panel on page 24).

2
3. Remove the front bezel (Front bezel on page 25).
4

Lift the metal clip that secures the speaker cable.

46 Chapter 6 Removal and replacement procedures



5.

6.

7.

Disconnect the speaker wire from the white system board connector labeled INT_SPKR.

@NOTE: System board appearance may vary.

From the inside of the computer, pull the rubber posts into the computer to disengage them.

2»NOTE: When attempting to disengage the rubber posts, it may help to move the posts back and
forth as you pull them into the chassis.

Pull the speaker into the computer.

Speaker
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To install the speaker, reverse the removal procedures.

When installing the speaker, when you pull the rubber posts from the front of the chassis to secure the
speaker, make sure to pull the posts until they click into place.
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Fan sink assembly

Description Spare part number

Fan sink 667727-001

1. Prepare the computer for disassembly (Preparation for disassembly on page 23).

Remove the access panel (Access panel on page 24).

Disconnect the fan sink cable from the white system board connector labeled CPU_FAN (1).

Lol S

Loosen the four captive Torx screws (2) that secure the fan sink to the system board.

%NOTE: System board appearance may vary.
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5. Lift the heat sink from the processor and set it on its side to keep from contaminating the work area
with thermal grease.

Reverse the removal procedures to install a fan sink.

When reinstalling an existing heat sink, make sure that its bottom has been cleaned with an alcohol
wipe and fresh thermal grease has been applied to the top of the processor. New heat sinks come from
the factory with fresh thermal grease already applied.

/\ CAUTION: Heat sink retaining screws should be tightened in diagonally opposite pairs (as in an X)
to evenly seat the heat sink to the processor. This is especially important as the pins on the socket are
very fragile and any damage to them may require replacing the system board.
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Processor

Description Spare part number
Intel Core i7-4770 processor, 3.4 GHz, 8-MB L3 cache, 86W 727373-001
Intel Core i5-4570 processor, 3.2 GHz, 6-MB L3 cache, 86 W 727380-001
Intel Core i3-4130 processor, 3.4 GHz, 3-MB L3 cache, 54W 742560-001
Intel Pentium G3220 processor, 3.0 GHz, 3-MB L3 cache, 54W 742564-001
Intel Celeron G1810 processor, 2.7 GHz, 2-MB L3 cache, 54W 758756-001

/\ CAUTION: To avoid damage, do NOT handle the pins in the processor socket. Damaged may
require system board replacement.

1. Prepare the computer for disassembly (Preparation for disassembly on page 23).

. Remove the access panel (Access panel on page 24).

2
3. Remove the fan sink Fan sink assembly on page 49).
4

. Rotate the locking lever to its full open position (1), raise and rotate the microprocessor retainer to
its full open position (2), and then carefully lift the processor from the socket (3).

/\ CAUTION: Heat sink retaining screws should be tightened in diagonally opposite pairs (as in an X)
to evenly seat the heat sink on the processor. This is especially important as the pins on the socket are
very fragile and any damage to them may require replacing the system board.

[Z7 NOTE: After installing a new processor onto the system board, always update the system ROM to
ensure that the latest version of the BIOS is being used on the computer. The latest system ROM BIOS
can be found at: http:\\h18000.www 1.hp.com/support/files

Processor 51


http://www.hp.com/support/

Power supply

Description Spare part number

Power supply, 300W, EStar 712298-001

Power supply, 300W, for use only in India and Southeast Asia 689005-001

/\ WARNING! Voltage is always present on the system board when the computer is plugged into an
active AC outlet. To avoid possible personal injury and damage to the equipment the power cord
should be disconnected from the computer and/or the AC outlet before opening the computer.

2»NOTE: When installing a new power supply, be sure fo set the red switch to the setting (230 V or
115 V) appropriate for the country in which the computer is used.

1. Prepare the computer for disassembly (Preparation for disassembly on page 23).

2. Remove the access panel (Access panel on page 24).

3. Disconnect the power cables from the system board connectors labeled ATX_CPU and ATX_PWR.
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4. From the rear of the computer, remove the four Torx screws that secure the power supply to the
chassis.

5. From the inside of the computer, cut the plastic tie that secures the power supply cables to the
drive cage.

6. Inside of the unit, press the power supply release latch on the chassis base (1).

Power supply
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7. Slide the power supply toward the front of the computer (2), then lift the power supply out of the
computer (3).

S ‘“F@,( € (o
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To install the power supply, reverse the removal procedure.
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System board

E%?NOTE: All system board spare part kits include replacement thermal material.

Description Spare part number
System board for use in non-Windows 8 models 787304-001
System board for use in models with Windows 8 Standard 787304-501
System board for use in models with Windows 8 Professional 787304-601

When replacing the system board, be sure that the following components are removed from the
defective system board and installed on the replacement system board:

Memory modules
Expansion cards
Fan sink

Processor

To remove the system board:

1.

aua ~ O N

Prepare the computer for disassembly (Preparation for disassembly on page 23).

Remove the access panel (Access panel on page 24).

Remove the front bezel (Front bezel on page 25).

Disconnect all cables from the system board.

Remove the five screws that secure the system board to the chassis.

System board
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6. Slide the system board toward the front of the chassis, and then lift it up and out of the chassis.

To install the system board, reverse the removal procedure.

@NOTE: When replacing the system board, you must also change the chassis serial number in the
BIOS.

E/?’NOTE: After installing a new system board, always update the system ROM to ensure that the latest
version of the BIOS is being used on the computer. The latest system ROM BIOS can be found at: http:\
\h18000.www1.hp.com/support/files.
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A Computer Setup (F10) Utility

Computer Setup (F10) Utilities

Use Computer Setup (F10) Utility to do the following:
e  Change factory default settings.
e Set the system date and time.

e  Set, view, change, or verify the system configuration, including settings for processor, graphics,
memory, audio, storage, communications, and input devices.

e  Modify the boot order of bootable devices such as hard drives, optical drives, or USB flash media
devices.

e  Enable Quick Boot, which is faster than Full Boot but does not run all of the diagnostic tests run
during a Full Boot. You can set the system to:

Q always Quick Boot (default);
Q periodically Full Boot (from every 1 to 30 days); or
Q always Full Boot.

e  Select Post Messages Enabled or Disabled to change the display status of Power-On Self-Test
(POST) messages. Post Messages Disabled suppresses most POST messages, such as memory
count, product name, and other non-error text messages. If a POST error occurs, the error is
displayed regardless of the mode selected. To manually switch to Post Messages Enabled during
POST, press any key (except F1 through F12).

o  Enter the Asset Tag or property identification number assigned by the company to this computer.

e Enable the power-on password prompt during system restarts (warm boots) as well as during
power-on.

e  Establish a setup password that controls access to the Computer Setup (F10) Utility and the settings
described in this section.

e  Secure infegrated 1/O functionality, including the serial, USB, or parallel ports, audio, or
embedded NIC, so that they cannot be used until they are unsecured.

e Enable or disable removable media boot ability.
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e  Solve system configuration errors detected but not automatically fixed during the Power-On Self-
Test (POST).

e Execute selftests on a specified ATA hard drive (when supported by drive).

e Enable or disable Drivelock security (when supported by drive).

Using Computer Setup (F10) Utilities

Computer Setup can be accessed only by turning the computer on or restarting the system. To access
the Computer Setup Utilities menu, complete the following steps:

1. Turn on or restart the computer.
2. Repeatedly press F10 when the monitor light turns green to access the utility.

You can also press Esc to a menu that allows you to access different options available at startup,
including the Computer Setup utility.

2 NOTE: If you do not press F10 at the appropriate time, you must restart the computer and again
repeatedly press F10 when the monitor light turns green to access the utility.

3. A choice of five headings appears in the Computer Setup Utilities menu: File, Storage, Security,
Power, and Advanced.

4. Use the arrow (left and right) keys to select the appropriate heading. Use the arrow (up and down)
keys to select the option you want, then press Enter. To return to the Computer Setup Utilities
menu, press Esc.

5. To apply and save changes, select File > Save Changes and Exit.

e If you have made changes that you do not want applied, select Ignore Changes and
Exit.

e To reset fo factory settings or previously saved default settings (some models), select Apply
Defaults and Exit. This option will restore the original factory system defaults.

E%?NOTE: Not all settings shown in the following sections are available for all models

/\ CAUTION: Do NOT turn the computer power OFF while the BIOS is saving the Computer Setup

(F10) changes because the CMOS could become corrupted. It is safe to turn off the computer only after
exiting the F10 Setup screen.
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Computer Setup—File

2»NOTE:  Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table A-1 Computer Setup—File

Option Description

System Information  Lists:
e  Manufacturer
e  Product name
e  SKU number
e  Serial Number
e Asset Tag
e Bornon Date
e  System Board ID
e  Product Configuration ID
e  System Board CT Number
e  BIOS Revision
e  BIOS Date
e  Processor Type
e  Processor Speed

e  Memory Size

About Displays copyright notice.

Set Time and Date Allows you to set system time and date.

Apply Defaults and  Applies the currently selected default settings and clears any established passwords.

Exit

Ignore Changes Exits Computer Setup without applying or saving any changes.

and Exit

Save Changes and  Saves changes to system configuration or default seftings and exits Computer Setup.
Exit
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2¥»NOTE: Support for specific Computer Setup options may vary depending on the hardware

configuration.

Table A-2 Computer Setup—Storage

Option

Description

Device
Configuration

Lists all installed BIOS-controlled storage devices.

When a device is selected, detailed information and options are displayed. The following options
may be presented:

e Hard Disk: Size, model, firmware version, serial number.

o  CD-ROM: Model, firmware version, serial number.

Storage Options

SATA Emulation

Allows you to choose how the SATA controller and devices are accessed by the operating system.
There are three supported options: IDE and AHCI (default).

CAUTION: SATA emulation changes may prevent access to existing hard drive data and
degrade or corrupt established volumes.

IDE - This is the most backwards-compatible sefting of the options. Operating systems usually do not
require additional driver support in IDE mode.

AHCI (default option) - Allows operating systems with AHCI device drivers loaded to take
advantage of more advanced features of the SATA controller.

Appendix A Computer Setup (F10) Utility



Table A-2 Computer Setup—Storage (continued)

Boot Order

Allows you to:

o EFI Boot Sources: Specify the order in which EFl boot sources (such as a internal hard drive,
USB hard drive, USB optical drive, or internal optical drive) are checked for a bootable
operating system image. Each device on the list may be individually excluded from or included
for consideration as a bootable operating system source.

EFI boot sources always have precedence over legacy boot sources.

e Legacy Boot Sources: Specify the order in which legacy boot sources (such as a network
interface card, internal hard drive, USB optical drive, or internal optical drive) are checked for
a bootable operating system image. Each device on the list may be individually excluded from
or included for consideration as a bootable operating system source.

Specify the order of attached hard drives. The first hard drive in the order will have priority in
the boot sequence and will be recognized as drive C (if any devices are attached).

NOTE: To drag a device fo a preferred place, press Enter. To remove the device from
consideration as a bootable device, press F5.

You can use F5 to disable individual boot items, as well as disable EFI boot and/or legacy boot.

NOTE: MS-DOS drive lettering assignments may not apply after a non-MS-DOS operating system
has started.

Shortcut to Temporarily Override Boot Order

To boot one time from a device other than the default device specified in Boot Order, restart the
computer and press Esc (fo access the boot menu) and then F9 (Boot Order), or only F9 (skipping
the boot menu) when the monitor light turns green. After POST is completed, a list of bootable
devices is displayed. Use the arrow keys to select the preferred bootable device and press Enter.
The computer then boots from the selected non-default device for this one time.

Computer Setup—Security

E’%NOTE: Support for specific Computer Setup options may vary depending on the hardware

configuration.

Table A-3 Computer Setup—Security

Option

Description

Setup Password

Allows you to set and enable a setup (administrator) password.

NOTE: If the setup password is set, it is required to change Computer Setup options, flash the
ROM, and make changes to certain plug and play settings under Windows.

Power-On
Password

Allows you to set and enable a power-on password. The power-on password prompt appears after
a power cycle or reboot. If the user does not enter the correct power-on password, the unit will not
boot.

Device Security

Allows you to set Device Available/Device Hidden (default is Device Available) for:
e  System audio
e  Network controller

e  SATA poris (varies by model)
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Table A-3 Computer Setup—Security (continued)

USB Security

Allows you to set Enabled/Disabled (default is Enabled) for:
e  Front USB Ports
e  Rear USB Ports

e  Accessory USB Ports

Slot Security

Allows you to disable any PCl or PCl Express slot. Default is enabled.

Network Boot

Enables/disables the computer’s ability to boot from an operating system installed on a network
server. (Feature available on NIC models only; the network controller must be either a PCI
expansion card or embedded on the system board.) Default is enabled.

System IDs

read-only unless entered using Cirl+A.
Allows you to set:

e  Product Name

e  Serial Number

e  Universal Unique Identifier (UUID) number. The UUID can only be updated if the current
chassis serial number is invalid. (These ID numbers are normally set in the factory and are used
to uniquely identify the system.)

e SKU Number
e  Family Name (always read-only)

e  Asset tag (18-byte identifier), a property identification number assigned by the company fo the
computer.

e  Feature Byte

e BuildID

e  Keyboard locale setting for System ID entry.
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Table A-3 Computer Setup—Security (continued)

System Security
(these options are
hardware dependent)

Data Execution Prevention (enable/disable) - Helps prevent operating system security breaches.
Default is enabled.

Virtualization Technology (enable/disable) - Controls the virtualization features of the processor.
Changing this setting requires turning the computer off and then back on. Default is disabled.

Secure Boot
Configuration

This is a feature of Windows 8.

e Llegacy Support—Enable/Disable. Allows you to turn off all legacy support on the computer,
including booting to DOS, running legacy graphics cards, booting to legacy devices, and so
on. If set to disable, legacy boot options in Storage > Boot Order are not displayed.
Default is enabled.

e  Secure Boot—Enable/Disable. Allows you to make sure an operating system is legitimate
before booting to it, making Windows resistant to malicious modification from preboot to full
OS booting, preventing firmware attacks. UEFI and Windows Secure Boot only allow code
signed by pre-approved digital certificates to run during the firmware and OS boot process.
Default is disabled, except for Windows 8 systems which have this setting enabled. Secure
Boot enabled also sets Legacy Support to disabled.

e  Key Management—This option lets you manage the custom key settings.

o Clear Secure Boot Keys—Don't Clear/Clear. Allows you to delete any previously loaded
custom boot keys. Default is Don't Clear.

o Key Ownership—HP Keys/Custom Keys. Selecting Custom Mode allows you to modify
the contents of the secure boot signature databases and the platform key (PK) that verifies
kernels during system start up, allowing you to use alternative operating systems.
Selecting HP Keys causes the computer boot using the preloaded HP-specific boot keys.
Default is HP Keys.

e  Fast Boot—Enable/Disable. Fast boot disables the ability to interrupt boot, such as pressing f
keys to access items before the operating system loads. Default is disabled.

NOTE: If Windows 8 detects a serious error, it will interrupt the boot process automatically
and display advanced boot options.

From Windows 8, you can press Shift and select Restart to access the screen that lets you
boot to a device or troubleshoot your computer.
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Computer Setup—Power

2¥»NOTE: Support for specific Computer Setup options may vary depending on the hardware

configuration.

Table A-4 Computer Setup—Power

Option

Description

Hardware Power

SATA Power Management — Enables or disables SATA bus and/or device power management.

Management Default is enabled.
S5 Wake on LAN - Enables or disables remotely waking up the computer from S5 (power is off)
power state. Default is disabled.

Thermal CPU Fan Speed - Display the CPU fan speed in rpm.

CPU Fan Check (<CTRL-A>/Advanced Mode only) — Enable/Disable the CPU Fan Check.

Computer Setup—Advanced
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E/?’NOTE: Support for specific Computer Setup options may vary depending on the hardware

configuration.

Option

Heading

Power-On Options

Allows you to set:

e  POST messages (enable/disable). Enabling this feature will cause the system to display POST
error messages, which are error messages displayed on the monitor during the Power On Self
Test if the BIOS encounters some kind of problem while starting the PC. A POST error message
will only display on screen if the computer is capable of booting this far. If the POST defects
an error before this point, a beep code is generated instead. Default is disabled.

e  After Power Loss (off/on/previous state). Default is Power off. Setting this option fo:
o Power off—causes the computer to remain powered off when power is restored.
° Power on—causes the computer to power on automatically as soon as power is restored.

° Previous state—causes the computer to power on automatically as soon as power is
restored, if it was on when power was lost.

NOTE: If you turn off power to the computer using the switch on a power strip, you will not be
able fo use the suspend/sleep feature or the Remote Management features.

e  POST Delay (in seconds). Enabling this feature will add a user-specified delay to the POST
process. This delay is sometimes needed for hard disks on some PCl cards that spin up very
slowly, so slowly that they are not ready to boot by the time POST is finished. The POST delay
also gives you more time to select F10 to enter Computer (F10) Setup. Default is None.

BIOS Power-On

Allows you to set the computer to turn on automatically at a time you specify.
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Bus Options

Allows you to enable or disable:

PCI SERR# Generation. Default is enabled.

PCl VGA Palette Snooping, which sets the VGA palette snooping bit in PCI configuration
space; only needed when more than one graphics controller is installed. Default is disabled.

Device Options

Allows you to set:

Num Lock State at Power-On (off/on). Default is on.

Internal Speaker (does not affect external speakers). Default is enabled.

NIC PXE Option ROM Download (enabled, disabled). Default is enable.

This option will be hidden when the Network Controller device security is set to Disable.

Multi-Processor (enable/disable). Use this option to disable multi-processor support under the
OS. Default is enabled.

Hyper threading (enable/disable). Use this option to disable processor hyper-threading.

Processor Frequency Multiplier - Available only via <CTRL-A>/Advanced Mode
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B Power cord set requirements

The power supplies on some computers have external power switches. The voltage select switch feature
on the computer permits it to operate from any line voltage between 100-120 or 220-240 volts AC.
Power supplies on those computers that do not have external power switches are equipped with
internal switches that sense the incoming voltage and automatically switch to the proper voltage.

The power cord set received with the computer meets the requirements for use in the country where you
purchased the equipment.

Power cord sefs for use in other countries must meet the requirements of the country where you use the
computer.

General requirements

The requirements listed below are applicable to all countries:

1. The power cord must be approved by an acceptable accredited agency responsible for evaluation
in the country where the power cord set will be installed.

2. The power cord set must have a minimum current capacity of 10A (7A Japan only) and a nominal
voltage rating of 125 or 250 volts AC, as required by each country’s power system.

3. The diameter of the wire must be a minimum of 0.75 mm, or 18AWG, and the length of the cord
must be between 1.8 m (6 feet) and 3.6 m (12 feet).

The power cord should be routed so that it is not likely to be walked on or pinched by items placed
upon it or against it. Particular attention should be paid to the plug, electrical outlet, and the point
where the cord exits from the product.

/\ WARNING! Do not operate this product with a damaged power cord set. If the power cord set is
damaged in any manner, replace it immediately.

Japanese power cord requirements

For use in Japan, use only the power cord received with this product.

/\ CAUTION: Do not use the power cord received with this product on any other products.
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Country-specific requirements

Additional requirements specific to a country are shown in parentheses and explained below.

Country Accrediting Agency Country Accrediting Agency
Australia (1) EANSW ltaly (1) IMQ

Austria (1) OVE Japan (3) METI

Belgium (1) CEBC Norway (1) NEMKO

Canada (2) CSA Sweden (1) SEMKO

Denmark (1) DEMKO Switzerland (1) SEV

Finland (1) SETI United Kingdom (1) BSI

France (1) UTE United States (2) uL

Germany (1) VDE

1. The flexible cord must be Type HO5VV-F, 3-conductor, 0.75mm, conductor size. Power cord set fittings (appliance
coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country where it
will be used.

2. The flexible cord must be Type SVT or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15A, 125V) or NEMA 6-15P (15A, 250V) configuration.

3. Appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. Flexible cord must be Type VCT or VCTF, 3-conductor, 0.75 mm, conductor size. Wall plug must
be a two-pole grounding type with a Japanese Industrial Standard C8303 (7A, 125V) configuration.
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POST Error Messages

This appendix lists the error codes, error messages, and the various indicator light and audible
sequences that you may encounter during Power-On Self-Test (POST) or computer restart, the probable
source of the problem, and steps you can take to resolve the error condition.

POST Message Disabled suppresses most system messages during POST, such as memory count and
non-error text messages. If a POST error occurs, the screen will display the error message. To manually
switch to the POST Messages Enabled mode during POST, press any key (except F10, F11, or F12).
The default mode is POST Message Disabled.

The speed at which the computer loads the operating system and the extent to which it is tested are
determined by the POST mode selection.

Quick Boot is a fast startup process that does not run all of the system level tests, such as the memory
test. Full Boot runs all of the ROM-based system tests and takes longer to complete.

Full Boot may also be enabled to run every 1 to 30 days on a regularly scheduled basis. To establish
the schedule, reconfigure the computer to the Full Boot Every x Days mode, using Computer Setup.

@NOTE: For more information on Computer Setup, see Computer Setup (F10) Utility on page 57.
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POST Numeric Codes and Text Messages

This section covers those POST errors that have numeric codes associated with them. The section also

includes some text messages that may be encountered during POST.

E’%NOTE: The computer will beep once after a POST text message is displayed on the screen.

Table C-1 Numeric Codes and Text Messages

Control panel message

Description

Recommended action

101-Option ROM Checksum Error System ROM or expansion board option 1. Verify the correct ROM.
ROM checksum.

2. Flash the ROM if needed.

3. If an expansion board was recently
added, remove it to see if the problem
remains.

4. Clear CMOS. (See Appendix B,
Password Security and Resetting CMOS
on page 77.)

5. If the message disappears, there may
be a problem with the expansion card.

6. Replace the system board.

103-System Board Failure DMA or timers. 1. Clear CMOS. (See Appendix B,
Password Security and Resetting CMOS
on page 77.)
2. Remove expansion boards.
3. Replace the system board.
110-Out of Memory Space for Option ROMs  Recently added PCl expansion card contains 1. If a PCl expansion card was recently
an option ROM too large to download added, remove it to see if the problem
during POST. remains.
2. In Computer Setup, set Advanced >

Device Options > NIC PXE Option
ROM Download to DISABLE to
prevent PXE option ROM for the internal
NIC from being downloaded during
POST to free more memory for an
expansion card's option ROM. Internal
PXE option ROM is used for booting
from the NIC to a PXE server.

POST Numeric Codes and Text Messages
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Table C-1 Numeric Codes and Text Messages (continued)

Control panel message

Description

Recommended action

162-System Options Not Set

Configuration incorrect.

RTC (realtime clock) battery may need to
be replaced.

Run Computer Setup and check the
configuration in Advanced > Onboard
Devices.

Reset the date and time under Control
Panel. If the problem persists, replace the
RTC battery. See the Removal and
Replacement section for instructions on
installing a new battery, or contact an
authorized dealer or reseller for RTC battery
replacement.

163-Time & Date Not Set

Invalid time or date in configuration memory.

RTC (realtime clock) battery may need to
be replaced.

Reset the date and time under Control
Panel (Computer Setup can also be used). If
the problem persists, replace the RTC
battery. See the Removal and Replacement
section for instructions on installing a new
battery, or contact an authorized dealer or
reseller for RTC battery replacement.

163-Time & Date Not Set

CMOS jumper may not be properly installed.

Check for proper placement of the CMOS
jumper if applicable.

164-MemorySize Error

Memory amount has changed since the last
boot (memory added or removed).

Press the F1 key to save the memory
changes.

164-MemorySize Error

Memory configuration incorrect.

1. Run Computer Setup or Windows
utilities.

2. Make sure the memory module(s) are
installed properly.

3.  If third-party memory has been added,
test using HP-only memory.

4. Verify proper memory module type.

201-Memory Error

RAM failure.

1. Ensure memory modules are correctly
installed.

2. Verify proper memory module type.

3. Remove and replace the identified
faulty memory module(s).

4. |f the error persists after replacing
memory modules, replace the system

board.

213-Incompatible Memory Module in
Memory Socket(s) X, X, ...

A memory module in memory socket
identified in the error message is missing
critical SPD information, or is incompatible
with the chipset.

1. Verify proper memory module type.
2. Try another memory socket.

3. Replace DIMM with a module
conforming to the SPD standard.

214-DIMM Configuration Warning

Populated DIMM Configuration is not
optimized.

Rearrange the DIMMs so that each channel
has the same amount of memory.
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Table C-1 Numeric Codes and Text Messages (continued)

Control panel message

Description

Recommended action

219-ECC Memory Module Detected ECC
Modules not supported on this Platform

Recently added memory module(s) support
ECC memory error correction.

1. If additional memory was recently
added, remove it to see if the problem
remains.

2. Check product documentation for
memory support information.

301-Keyboard Error

Keyboard failure.

1. Reconnect keyboard with computer
turned off.

2. Check connector for bent or missing
pins.

3. Ensure that none of the keys are
depressed.

4. Replace keyboard.

303-Keyboard Controller Error

1/O board keyboard controller.

1. Reconnect keyboard with computer
turned off.

2. Replace the system board.

304-Keyboard or System Unit Error

Keyboard failure.

1. Reconnect the keyboard with computer
turned off.

2. Ensure that none of the keys are
depressed.

3. Replace the keyboard.

4. Replace the system board.

501-Display Adapter Failure

Graphics display controller.

1. Reseat the graphics card (if applicable).

2. Clear CMOS. (See Appendix B,
Password Security and Resetting CMOS

on page 77.)

3.  Verify monitor is attached and turned
on.

4. Replace the graphics card (if possible).

510-Flash Screen Image Corrupted

Flash Screen image has errors.

Reflash the system ROM with the latest BIOS
image.

511-CPU, CPUA, or CPUB Fan not Detected

CPU fan is not connected or may have
malfunctioned.

1. Reseat CPU fan.
2. Reseat fan cable.

3. Replace CPU fan.

512-Chassis, Rear Chassis, or Front Chassis
Fan not Detected

Chassis, rear chassis, or front chassis fan is
not connected or may have malfunctioned.

1. Reseat chassis, rear chassis, or front
chassis fan.

2. Reseat fan cable.

3. Replace chassis, rear chassis, or front
chassis fan.
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Table C-1 Numeric Codes and Text Messages (continued)

Control panel message

Description

Recommended action

513-Front Chassis fan not detected

Front chassis fan is not connected or may
have malfunctioned.

1. Reseat front chassis fan.
2. Reseat fan cable.

3. Replace front chassis fan.

514-CPU or Chassis Fan not Detected

CPU or chassis fan is not connected or may
have malfunctioned.

1. Reseat CPU or chassis fan.
2. Reseat fan cable.

3. Replace CPU or chassis fan.

515-Power Supply fan not detected

Power supply fan is not connected or may
have malfunctioned.

1. Reseat power supply fan.
2. Reseat fan cable.

3. Replace power supply fan.

660-Display cache is detected unreliable

Integrated graphics controller display cache

is not working properly and will be disabled.

Replace system board if minimal graphics
degrading is an issue.

912-Computer Cover Has Been Removed
Since Last System Startup

Computer cover was removed since last
system startup.

No action required.

917-Front Audio Not Connected

Front audio harness has been detached or
unseated from motherboard.

Reconnect or replace front audio harness.

918-Front USB Not Connected

Front USB harness has been detached or
unseated from motherboard.

Reconnect or replace front USB harness.

921-Device in PCl Express slot failed to
initialize

There is an incompatibility/problem with this
device and the system or PCl Express Link
could not be retrained to an x1.

Try rebooting the system. If the error
reoccurs, the device may not work with this
system

1796-SATA Cabling Error

One or more SATA devices are improperly
attached. For optimal performance, the
SATA 0 and SATA 1 connecfors must be
used before SATA 2 and SATA 3.

Ensure SATA connectors are used in
ascending order. For one device, use SATA
0. For two devices, use SATA 0 and SATA
1. For three devices, use SATA 0, SATA 1,
and SATA 2.

1797-SATA Drivelock is not supported in
RAID mode.

Drivelock is enabled on one or more SATA
hard drives, and they cannot be accessed
while the system is configured for RAID
mode.

Either remove the Drivelocked SATA device
or disable the Drivelock feature. To disable
the Drivelock feature, enter Computer Setup,
change Storage > Storage Options >
SATA Emulation to IDE, and select File >
Save Changes and Exit. Reenter
Computer Setup and select Security >
Drivelock Security. For each listed
Drivelock-capable SATA device, ensure
Drivelock is Disabled. Lastly, change
Storage > Storage Options > SATA
Emulation back to RAID and select File >
Save Changes and Exit.

1801-Microcode Patch Error

Processor is not supported by ROM BIOS.

1. Upgrade BIOS to proper version.

2. Change the processor.
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Table C-1 Numeric Codes and Text Messages (continued)

Control panel message

Description

Recommended action

2200-PMM Allocation Error during MEBx
Download

Memory error during POST execution of the
Management Engine (ME) BIOS Extensions
option ROM.

1. Reboot the computer.

2. Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3. If the memory configuration was
recently changed, unplug the computer,
restore the original memory

configuration, and reboot the computer.

4. |f the error persists, replace the system

board.

2201-MEBx Module did not checksum
correctly

Memory error during POST execution of the
Management Engine (ME) BIOS Extensions
option ROM.

1. Reboot the computer.

2. Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3. If the memory configuration was
recently changed, unplug the power
cord, restore the original memory

configuration, and reboot the computer.

4. |If the error persists, replace the system

board.

2202-PMM Deallocation Error during MEBx
cleanup

Memory error during POST execution of the
Management Engine (ME) BIOS Extensions
option ROM.

1. Reboot the computer.

2. Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3. If the memory configuration was
recently changed, unplug the power
cord, restore the original memory

configuration, and reboot the computer.

4. |f the error persists, replace the system

board.

2203-Setup error during MEBx execution

MEBx selection or exit resulted in a setup
failure.

1. Reboot the computer.

2. Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3. If the memory configuration was
recently changed, unplug the power
cord, restore the original memory

configuration, and reboot the computer.

4. |f the error persists, replace the system

board.
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Table C-1 Numeric Codes and Text Messages (continued)

Control panel message

Description

Recommended action

2204-Inventory error during MEBx execution

BIOS information passed to the MEBx
resulted in a failure.

1. Reboot the computer.

2. |f the error persists, update to the latest
BIOS version.

3.  If the error still persists, replace the
system board.

2205-Interface error during MEBx execution

MEBx operation experienced a hardware
error during communication with ME.

1. Reboot the computer.

2. |If the error persists, update to the latest
BIOS version.

3.  If the error still persists, replace the
system board.

2211-Memory not configured correctly for
proper MEBx execution.

DIMM1 or XMMT1 is not installed.

Make sure there is a memory module in the
black DIMM1 socket and that it is properly
seated.

2212-USB Key Provisioning failure writing to
device

USB device used for USB key provisioning
will not allow BIOS to update provision file

properly.

1. Try a different USB key device for
provisioning.

2. |If the error persists, update to the latest
BIOS version and ME firmware version.

3.  If the error still persists, replace the
system board.

2217-ME Firmware Version request failure

ME firmware is not properly responding to
BIOS query for version information.

1. Reboot the computer.

2. |If the error persists, update to the latest
BIOS version and ME firmware version.

3.  |If the error still persists, replace the
system board.

2218-ME Firmware Version should be
updated

ME firmware must be updated to match
current functionality contained in the system
BIOS.

1. Update to the latest ME firmware
version.

2.  If the error persists and system BIOS
has been recently updated, restore
previous system BIOS version.

3. If the error still persists, replace the
system board.

2219-USB Key Provisioning file has invalid
header identifier

Provisioning file contained on the USB key
has been corrupted or is not a valid version
for the current ME firmware.

1. Recreate the provisioning file using third
party management console software.

2. |f the error persists and system BIOS
has been recently updated, restore
previous system BIOS version.
Otherwise, update the ME firmware
version.

3.  If the error still persists, replace the
system board.
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Table C-1 Numeric Codes and Text Messages (continued)

Control panel message

Description

Recommended action

2220-USB Key Provisioning file has
mismatch version

Provisioning file contained on the USB key is
not a valid version for the current ME
firmware.

1. Reboot the computer.

2. If the error persists and system BIOS
has been recently updated, restore
previous system BIOS version.
Otherwise, update the ME firmware
version.

3. If the error still persists, replace the
system board.

2230-General error during MEBx execution

Error occurred during MEBx execution which
fails into the “General” grouping. Status
information displayed along with the error
provides further clarity into the failure. MEBx
handles transference of information between
the system BIOS and ME firmware.

1. Reboot the computer.

2. |If the error persists, update to the latest

BIOS version and ME firmware version.

3.  If the error still persists, replace the
system board.

2231-ME error during MEBx execution

Error occurred during MEBx execution which
fails info “ME” grouping.

1. Reboot the computer.

2. |If the error persists, update to the latest

BIOS version and ME firmware version.

3. |If the error still persists, replace the
system board.

2232-AMT error during MEBx execution

Error occurred during MEBx execution which
fails into “AMT” grouping.

1. Reboot the computer.

2. |f the error persists, update to the latest

BIOS version and ME firmware version.

3. If the error still persists, replace the
system board.

2233-HECI error during MEBx execution

Error occurred during MEBx execution which

fails into “MEI or HECI” grouping.

1. Reboot the computer.

2. |If the error persists, update to the latest

BIOS version and ME firmware version.

3. If the error still persists, replace the
system board.

2239-ME image lock failure

Special system configurations with reduced
ME firmware image require BIOS control of
ME firmware upgrading. A failure has
occurred after the ME firmware update
process in which the BIOS could not relock
the ME firmware region.

1. Reboot the computer.

2. |If the error persists, update to the latest

BIOS version and ME firmware version.

3. If the error still persists, replace the
system board.

2240-ME image unlock failure

Special system configurations with reduced
ME firmware image require BIOS control of
ME firmware upgrading. A failure has
occurred prior to the ME firmware update
process in which the BIOS could not unlock
the ME firmware region.

1. Reboot the computer.

2. |If the error persists, update to the latest

BIOS version and ME firmware version.

3.  If the error still persists, replace the
system board.

POST Numeric Codes and Text Messages

75



Table C-1 Numeric Codes and Text Messages (continued)

Control panel message Description Recommended action

Invalid Electronic Serial Number Electronic serial number is missing. Enter the correct serial number in Computer
Setup.

Network Server Mode Active and No Keyboard failure while Network Server 1. Reconnect keyboard with computer

Keyboard Attached Mode enabled. turned off.

2. Check connector for bent or missing
pins.

3. Ensure that none of the keys are
depressed.

4. Replace keyboard.

Parity Check 2 Parity RAM failure. Run Computer Setup and Diagnostic utilities.

Interpreting POST Diagnostic Front Panel LEDs and
Audible Codes

During the system validation phase, the BIOS will validate the functionality of the CPU, memory,
graphics, system board and all other platform components. Since the display may not be functional, the
power button LED and the speaker will be used to indicate an error. The speaker will be used so that a
support agent can detect the error code over the phone. The pattern of the blink/beep error indicator
will be 1 blink/beep per second followed by a 2 second pause at the end of the sequence. The
sequence will repeat for 5 cycles. After the 5 cycles are complete, only the blink will continue.

/\ WARNING! When the computer is plugged into an AC power source, voltage is always applied to
the system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure fo disconnect the power cord from the wall outlet and allow the internal system components to cool
before touching.

Test Failure Power Speaker
button LED
CPU CPU not functional 1 blink 1 beep
BIOS BIOS corruption 2 blinks 2 beeps
Memory Module error 3 blinks 3 beeps
Graphics No controller 4 blinks 4 beeps
System board Other failure 5 blinks 5 beeps
BIOS Authentication failure, if supported 6 blinks 6 beeps
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Password Security and Resetting
CMOS

This computer supports security password features, which can be established through the Computer
Setup Utilities menu.

This computer supports two security password features that are established through the Computer Setup
Utilities menu: setup password and power-on password. When you establish only a setup password,
any user can access all the information on the computer except Computer Setup. When you establish
only a power-on password, the power-on password is required to access Computer Setup and any
other information on the computer. When you establish both passwords, only the setup password will
give you access to Computer Setup.

When both passwords are set, the setup password can also be used in place of the power-on
password as an override to log in to the computer. This is a useful feature for a network administrator.

If you forget the password for the computer, you can clear that password so you can gain access to the
information on the computer by resetting the password jumper.

/\ CAUTION:  Pushing the CMOS button will reset CMOS values to factory defaults. It is important to
back up the computer CMOS settings before resetting them in case they are needed later. Back up is
easily done through Computer Setup. See Computer Setup (F10) Utility on page 57 for information on
backing up the CMOS settings.
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Resetting the Password Jumper
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To disable the power-on or setup password features, or to clear the power-on or setup passwords,
complete the following steps:

1. Shut down the operating system properly, then turn off the computer and any external devices,
and disconnect the power cord from the power outlet.

2. With the power cord disconnected, press the power button again to drain the system of any
residual power.

/\ WARNING! To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure fo disconnect the power cord from the wall outlet, and allow the internal system components
to cool before touching.

/\ CAUTION: When the computer is plugged in, the power supply always has voltage applied to
the system board even when the unit is turned off. Failure to disconnect the power cord can result
in damage fo the system.

Static electricity can damage the electronic components of the computer or optional equipment.
Before beginning these procedures, ensure that you are discharged of static electricity by briefly
touching a grounded metal object. See the Safety & Regulatory Information guide for more
information.

3. Remove the access panel.

4. Llocate the header and jumper labeled CLR_CMOS/PASS.

E%?NOTE: The password jumper is blue so that it can be easily identified.

5. Remove the top jumper from pins 2 and 3.

6. Place the jumper on pins 1 or 2.

7. Replace the access panel and reconnect the external equipment.
8

Plug in the computer and turn on power. Allow the operating system to start. This clears the current
passwords and disables the password features.

9. Shut down the computer, unplug the power, and disconnect the external equipment.
10. Remove the access panel.

11. Put the jumper back on pins 2 or 3.

12. Replace the access panel.

13. Reconnect the external equipment.

14. Plug in the computer and turn on power. Allow the operating system to start. This clears the current
passwords and disables the password features.

15. To establish new passwords, use Computer Setup.
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Clearing and Resetting the CMOS

The computer’s configuration memory (CMOS) stores information about the computer’s configuration.
The CMOS button resets CMOS but does not clear the power-on and setup passwords.

Clearing CMOS will clear the Active Management Technology (AMT) settings in the Management
Engine BIOS Extension (MEBx), including the password. The password will default to “admin” and will
need to be reset. The AMT settings will also need to be reset. To access the MEBx, press Ctrl+P during
POST.

1. Shut down the operating system properly, then turn off the computer and any external devices,
and disconnect the power cord from the power outlet.

2. With the power cord disconnected, press the power button again to drain the system of any
residual power.

/A WARNING! To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure fo disconnect the power cord from the wall outlet, and allow the internal system components
to cool before touching.

/\ CAUTION: When the computer is plugged in, the power supply always has voltage applied to
the system board even when the unit is turned off. Failure to disconnect the power cord can result
in damage to the system.

Static electricity can damage the electronic components of the computer or optional equipment.
Before beginning these procedures, ensure that you are discharged of static electricity by briefly
touching a grounded metal object.

3. Remove the access panel.

4. Llocate the header and jumper labeled CLR_CMOS/PASS.

@NOTE: The password jumper is blue so that it can be easily identified.

5. Remove the bottom jumper from pins 2 and 3.

6. Place the jumper on pins 1 or 2.

7. Replace the access panel and reconnect the external equipment.
8

Plug in the computer and turn on power. Allow the operating system to start. This clears the
CMOS.

9. Shut down the computer, unplug the power, and disconnect the external equipment.
10. Remove the access panel.
11. Put the jumper back on pins 2 or 3.

12. Replace the access panel.
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13. Reconnect the external equipment.

14. Plug in the computer and turn on power. Allow the operating system to start. This clears the current
passwords and disables the password features.

@NOTE: You will receive POST error messages after clearing CMOS and rebooting advising you that
configuration changes have occurred. Use Computer Setup to reset any special system setups along
with the date and time.

For instructions on Computer Setup, see Computer Setup (F10) Utility on page 57.
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E Troubleshooting without
diagnostics

This chapter provides information on how to identify and correct minor problems, such as USB devices,
hard drive, optical drive, graphics, audio, memory, and software problems. If you encounter problems
with the computer, refer to the tables in this chapter for probable causes and recommended solutions.

2 NOTE: For information on specific error messages that may appear on the screen during Power-On
Self-Test (POST) at startup, refer to Appendix A, POST Error Messages on page 68.

Safety and comfort

/\ WARNING! Misuse of the computer or failure to establish a safe and comfortable work environment
may result in discomfort or serious injury. Refer to the Safety & Comfort Guide at http://www.hp.com/
ergo for more information on choosing a workspace and creating a safe and comfortable work
environment. For more information, refer to the Safety & Regulatory Information guide.

Before you call for technical support

It you are having problems with the computer, try the appropriate solutions below to try to isolate the
exact problem before calling for technical support.

Run the HP diagnostic tool.

Run the hard drive self-test in Computer Setup. Refer to Computer Setup (F10) Utility on page 57
for more information.

Check the Power LED on the front of the computer to see if it is flashing red. The flashing lights are
error codes that will help you diagnose the problem. Refer to Appendix A, POST Error Messages
on page 68 for more information.

If the screen is blank, plug the monitor into a different video port on the computer if one is
available. Or, replace the monitor with a monitor that you know is functioning properly.

If you are working on a network, plug another computer with a different cable into the network
connection. There may be a problem with the network plug or cable.

If you recently added new hardware, remove the hardware and see if the computer functions
properly.
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If you recently installed new software, uninstall the software and see if the computer functions
properly.

Boot the computer to the Safe Mode to see if it will boot without all of the drivers loaded. When
booting the operating system, use “Last Known Configuration.”

Refer to the comprehensive online technical support at http://www.hp.com/support.

Refer to Helpful hints on page 82 in this guide.

To assist you in resolving problems online, HP Instant Support Professional Edition provides you with
self-solve diagnostics. If you need to contact HP support, use HP Instant Support Professional Edition's
online chat feature. Access HP Instant Support Professional Edition at: http://www.hp.com/go/ispe.

Access the Business Support Center (BSC) at http://www.hp.com/go/bizsupport for the latest online
support information, software and drivers, proactive notification, and worldwide community of peers
and HP experts.

If it becomes necessary to call for technical assistance, be prepared to do the following to ensure that
your service call is handled properly:

Be in front of your computer when you call.

Write down the computer serial number, product ID number, and monitor serial number before
calling.

Spend time troubleshooting the problem with the service technician.
Remove any hardware that was recently added to your system.
Remove any software that was recently installed.

Restore the system from the Recovery Disc Set that you created or restore the system fo its original
factory condition in System Software Requirement Disks (SSRD).

/\ CAUTION: Restoring the system will erase all data on the hard drive. Be sure to back up all data
files before running the restore process.

E/?’NOTE: For sales information and warranty upgrades (Care Packs), call your local authorized service
provider or dedaler.

Helpful hints

If you encounter problems with the computer, monitor, or software, see the following list of general
suggestions before taking further action:
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Check that the computer and monitor are plugged into a working electrical outlet.

Check that the voltage select switch (some models) is set to the appropriate voltage for your region
(115V or 230V).

Check that the computer is turned on and the white power light is on.

Check that the monitor is turned on and the green monitor light is on.
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e  Check the Power LED on the front of the computer to see if it is flashing red. The flashing lights are
error codes that will help you diagnose the problem. Refer to Appendix A, POST Error Messages
on page 68 for more information.

e  Turn up the brightness and contrast controls of the monitor if the monitor is dim.
e Press and hold any key. If the system beeps, then the keyboard should be operating correctly.
o  Check all cable connections for loose connections or incorrect connections.

e  Wake the computer by pressing any key on the keyboard or pressing the power button. If the
system remains in suspend mode, shut down the computer by pressing and holding the power
button for at least four seconds then press the power button again to restart the computer. If the
system will not shut down, unplug the power cord, wait a few seconds, then plug it in again. The
computer will restart if it is set fo power on automatically as soon as power is restored in
Computer Setup. If it does not restart, press the power button to start the computer.

e  Reconfigure the computer after installing a non-plug and play expansion board or other option.
See Solving Hardware Installation Problems on page 104 for instructions.

e  Be sure that all the needed device drivers have been installed. For example, if you are using a
printer, you need a driver for that model printer.

e Remove all bootable media (CD/DVD or USB device) from the system before turning it on.

e If you have installed an operating system other than the factory-installed operating system, check
to be sure that it is supported on the system.

e If the system has multiple video sources (embedded, PCl, or PCl-Express adapters) installed
(embedded video on some models only) and a single monitor, the monitor must be plugged into
the monitor connector on the source selected as the primary VGA adapter. During boot, the other
monitor connectors are disabled and if the monitor is connected into these ports, the monitor will
not function. You can select which source will be the default VGA source in Computer Setup.

/\ CAUTION: When the computer is plugged into an AC power source, there is always voltage
applied to the system board. You must disconnect the power cord from the power source before
opening the computer to prevent system board or component damage.
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Solving general problems

You may be able to easily resolve the general problems described in this section. If a problem persists
and you are unable to resolve it yourself or if you feel uncomfortable about performing the operation,

contact an authorized dealer or reseller.

/\ WARNING! When the computer is plugged into an AC power source, voltage is always applied to

the system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure fo disconnect the power cord from the wall outlet and allow the internal system components to cool

before touching.

Computer appears locked up and will not turn off when the power button is pressed.

Cause

Solution

Software control of the power switch is not functional.

1. Press and hold the power button for at least four seconds
until the computer turns off.

2. Disconnect the power cord from the electrical outlet.

Computer will not respond to keyboard or mouse.

Cause

Solution

Computer is in Sleep state.

To resume from Sleep state, press the power button.

CAUTION: When attempting to resume from Sleep state,
do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you will
lose any unsaved data.

System has locked up.

Restart computer.

Computer date and time display is incorrect.

Cause

Solution

RTC (realtime clock) battery may need to be replaced.

NOTE: Connecting the computer to a live AC outlet
prolongs the life of the RTC battery.

Reset the date and time under Control Panel (Computer
Setup can also be used to update the RTC date and time). If
the problem persists, replace the RTC battery. See the
Removal and Replacement section for instructions on installing
a new battery, or contact an authorized dealer or reseller for
RTC battery replacement.

To access Control Panel in Windows 7, select Start, and then
select Control Panel.

To access Control Panel in Windows 8, from the Start screen,
type c, and then select Control Panel from the list of
applications.
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Cursor will not move using the arrow keys on the keypad.

Cause

Solution

The Num Lock key is turned on.

Press the Num Lock key. The Num Lock light must be off if you
want to use the arrow keys on the keypad. You can also
disable or enable the Num Lock key in Computer Setup at
Advanced > Device Options.

There is no sound or sound volume is too low.

Cause

Solution

System volume may be set low or muted.

1. Check the Computer Setup settings to make sure the
internal system speaker is not muted (this sefting does not
affect the external speakers).

2. Make sure the external speakers are properly connected
and powered on and that the speakers' volume control is
set correctly.

3. Use the system volume control available in the operating
system to make sure the speakers are not muted or to
increase the volume.

Cannot remove computer cover or access panel.

Cause

Solution

Smart Cover Lock, featured on some computers, is locked.

Unlock the Smart Cover Lock using Computer Setup.

In case of forgotten password, power loss, or computer
malfunction, you must manually disable the Smart Cover lock .
A key to unlock the Smart Cover Lock is not available from
HP. Keys are typically available from a hardware store.

Poor performance.

Cause

Solution

Processor is too hot.

1. Make sure airflow to the computer is not blocked. Leave
a 10.2-cm (4-inch) clearance on all vented sides of the
computer and above the monitor to permit the required
airflow.

2. Make sure fans are connected and working properly
(some fans only operate when needed).

3. Make sure the processor heat sink is installed properly.

Hard drive is full.

Transfer data from the hard drive to create more space on the

hard drive.

Low on memory.

Add more memory.

Solving general problems
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Poor performance.

Cause

Solution

Hard drive fragmented.

Defragment hard drive.

Program previously accessed did not release reserved memory
back to the system.

Restart the computer.

Virus resident on the hard drive.

Run virus protection program.

Too many applications running.

1.

2.

Close unnecessary applications to free up memory.
Add more memory.

Some applications run in the background and can be
closed by right-clicking on their corresponding icons in
the task tray. To prevent these applications from
launching at startup:

In Windows 7:

a. Go to Start > All Programs > Accessories >
Run

b. Type msconfig, and then press Enter.

c.  On the Startup tab of the System Configuration
Utility, clear applications that you do not want to
launch automatically, and the click OK.

In Windows 8:

a. On the Start screen, rightclick, and then select the
All apps icon.

b. Under Windows System, click Run.
c. Typemsconfig, and then press Enter.

d. On the Startup tab of the System Configuration
Utility, clear applications that you do not want to
launch automatically, and the click OK.

Some software applications, especially games, are stressful on
the graphics subsystem.

1.

2.

3.

Lower the display resolution for the current application or
consult the documentation that came with the application
for suggestions on how to improve performance by
adjusting parameters in the application.

Add more memory.

Upgrade the graphics solution.

Cause unknown.

Restart the computer.
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Computer powered off automatically and the Power LED flashes Red two times, once every second,
followed by a two second pause, and the computer beeps two times. (Beeps stop after fifth iteration but

LEDs continue flashing).

Cause Solution

Processor thermal protection activated: 1.
A fan may be blocked or not turning.

OR

The heat sink is not properly attached to the processor.

Ensure that the computer air vents are not blocked and
the processor cooling fan is running.

Open the access panel, press the power button, and see
if the processor fan (or other system fan) spins. If the fan
does not spin, make sure the fan cable is plugged onto
the system board header.

If fan a plugged in and not spinning, replace it.

System does not power on and the LEDs on the front of the computer are not flashing.

Cause Solution

System unable to power on. Press and hold the power button for less than 4 seconds. If the
hard drive LED turns white, then:

1.

3.

OR

If equipped with a voltage selector, check that the
voltage selector (located on the rear of the power supply)
is set to the appropriate voltage. Proper voltage setting
depends on your region.

Remove the expansion cards one at a time until the
5V_aux light on the system board turns on.

Replace the system board.

Press and hold the power button for less than 4 seconds. If the
hard drive LED does not turn on white then:

1.

2.

Check that the unit is plugged into a working AC outlet.

Open the access panel and check that the power button
cable is properly connected to the system board.

Check that the power supply cables are properly
connected to the system board.

Check to see if the 5V_aux light on the system board is
turned on. If it is turned on, then replace the power
button assembly.

If the 5V_aux light on the system board is off, then
replace the power supply.

Replace the system board.

Solving general problems

87



Solving power problems
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Common causes and solutions for power problems are listed in the following table.

Power supply shuts down intermittently.

Cause

Solution

If equipped with a voltage selector, voltage selector switch on

rear of computer chassis (some models) not switched to
correct line voltage (115V or 230V).

Select the proper AC voltage using the selector switch.

Power supply will not turn on because of internal power
supply fault.

Replace the power supply.

Computer powered off automatically and the Power LED flashes Red two times, once every second,
followed by a two second pause, and the computer beeps two times. (Beeps stop after fifth iteration but

LEDs continue flashing.)

Cause

Solution

Processor thermal protection activated:
A fan may be blocked or not turning.
OR

The heat sink is not properly attached to the processor.

1.

Ensure that the computer air vents are not blocked and
the processor cooling fan is running.

Open the access panel, press the power button, and see
if the processor fan (or other system fan) spins. If the fan
does not spin, make sure the fan cable is plugged onto
the system board header.

If fan a plugged in and not spinning, replace it.

Appendix E  Troubleshooting without diagnostics



Power LED flashes Red four times, once every second, followed by a two second pause, and the
computer beeps four times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause

Solution

Power failure (power supply is overloaded).

1.

If equipped with a voltage selector, check that the
voltage selector, located on the rear of the power supply
(some models), is set to the appropriate voltage. Proper
voltage setting depends on your region.

Open the access panel and ensure the power supply
cable is seated into the connector on the system board.

Check if a device is causing the problem by removing
ALL attached devices (such as hard drives or optical
drives and expansion cards). Power on the system. If the
system enters POST, then power off and replace one
device at a time and repeat this procedure until failure
occurs. Replace the device that is causing the failure.
Continue adding devices one at a time to ensure all
devices are functioning properly.

Replace the power supply.

Replace the system board.

Solving hard drive problems

Hard drive error occurs.

Cause

Solution

Hard disk has bad sectors or has failed.

1.

In Windows 7, click Start, click Computer, and right-
click on a drive. Select Properties, and then select the
Tools tab. Under Error-checking click Check Now.

In Windows 8, on the Start screen type e, and then
select File Explorer from the list of applications. In the
left column, expand Computer, right-click on a drive,
select Properties, and then select the Tools tab. Under
Error checking click Check.

Use a utility to locate and block usage of bad sectors. If
necessary, reformat the hard disk.

Solving hard drive problems

89



Disk transaction problem.

Cause

Solution

Either the directory structure is bad or there is a problem with
a file.

In Windows 7, click Start, expand Computer, and right-
click on a drive. Select Properties, and then select the
Tools tab. Under Error-checking click Check Now.

In Windows 8, on the Start screen type e, and then click File
Explorer from the list of applications. In the left column,
expand Computer, rightclick on a drive, select Properties,
and then select the Tools tab. Under Error checking click
Check.

Drive not found (identified).

Cause

Solution

Cable could be loose.

Check cable connections.

The system may not have automatically recognized a newly
installed device.

See reconfiguration directions in the Solving Hardware
Installation Problems on page 104 section. If the system still
does not recognize the new device, check to see if the device
is listed within Computer Setup. If it is listed, the probable
cause is a driver problem. If it is not listed, the probable cause
is a hardware problem.

If this is a newly installed drive, run the Computer Setup utility
and try adding a POST delay under Advanced > Power-
On Options.

The device is attached to a SATA port that has been hidden in
Computer Setup.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Drive responds slowly immediately after power-up.

Run Computer Setup and increase the POST Delay in
Advanced > Power-On Options.

Nonsystem disk/NTLDR missing message.

Cause

Solution

The system is trying fo start from the hard drive but the hard
drive may have been damaged.

1. Perform Drive Protection System (DPS) testing in F2
Diagnostics (reboot the computer and press F2 before
the operating system starts).

System files missing or not properly installed.

1. Insert bootable media and restart the computer.

2. Boot to the windows installation media and select the
recovery option. If only a restore kit is available, then
select the File Backup Program option, and then
restore the system.

3. Install system files for the appropriate operating system.

Hard drive boot has been disabled in Computer Setup.

Run the Computer Setup utility and enable the hard drive entry
in the Storage > Boot Order list.
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Nonsystem disk/NTLDR missing message.

Cause

Solution

Bootable hard drive is not attached as first in a multi-hard
drive configuration.

If attempting to boot from a hard drive, ensure it is attached to
the system board dark blue SATA connector.

Bootable hard drive is not listed first in the Boot Order.

Run the Computer Setup utility and select Storage > Boot
Order and ensure the bootable hard drive is listed
immediately under the Hard Drive entry.

Computer will not boot from hard drive.

Cause

Solution

The device is attached to a SATA port that has been hidden in
Computer Setup.

1. Check SATA cable connections.

2. Run the Computer Setup utility and ensure Device
Available is selected for the device's SATA port in
Security > Device Security.

Boot order is not correct.

Run the Computer Setup utility and change boot sequence in
Storage > Boot Order.

Hard Drive's “Emulation Type” is set to “None.” (some
models)

Run the Computer Setup utility and change the “Emulation
Type” to “Hard Disk” in the device's details under Storage >
Device Configuration.

Hard drive is damaged.

Observe if the front panel Power LED is blinking RED and if
any beeps are heard. See Appendix A, POST Error Messages
on page 68 to determine possible causes for the blinking red
and beep codes.

See the Worldwide Limited Warranty for terms and
conditions.

Computer seems to be locked up.

Cause

Solution

Program in use has stopped responding to commands.

1. Use the task manager to close programs that do not
respond.

2. Attempt the normal Windows “Shut Down” procedure. If
this fails, press the power button for four or more
seconds to turn off the power. To restart the computer,
press the power button again.
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Media card will not work in a digital camera after formatting it in Windows.

Cause

Solution

By default, Windows will format any media card with a
capacity greater than 32MB with the FAT32 format. Some
digital cameras use the FAT (FAT16 & FAT12) format and can
not operate with a FAT32 formatted card.

Either format the media card in the digital camera or select
FAT file system to format the media card in a computer with

Windows.

A write-protected or locked error occurs when attempting to write to the media card.

Cause

Solution

Media card is locked. Locking the media card is a safety
feature that prevents writing to and deleting from an SD/
Memory Stick/PRO card.

If using an SD card, make sure that the lock tab located on the
right of the SD card is not in the locked position. If using a
Memory Stick/PRO card, make sure that the lock tab located
on the bottom of the Memory Stick/PRO card is not in the
locked position.

Can not write to the media card.

Cause

Solution

The media card is a read-only memory (ROM) card.

Check the manufacturer’'s documentation included with your
card to see if it writable. Refer to the previous section for a list
of compatible cards.

Media card is locked. Locking the media card is a safety
feature that prevents writing fo and deleting from an SD/
Memory Stick/PRO card.

If using an SD card, make sure that the lock tab located on the
right of the SD card is not in the locked position. If using a
Memory Stick/PRO card, make sure that the lock tab located
on the bottom of the Memory Stick/PRO card is not in the
locked position.

Unable to access data on the media card after inserting it into a slot.

Cause

Solution

The media card is not inserted properly, is inserted in the
wrong slot, or is not supported.

Ensure that the card is inserted properly with the gold contact
on the correct side. The green LED will light if inserted

properly.
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Do not know how to remove a media card correctly.

Cause Solution

The computer’s software is used to safely eject the card. In Windows 7, click Start, select Computer, right-click on
the corresponding drive icon, and then select Eject. Pull the
card out of the slot.

In Windows 8, on the Start screen, type e, and then click File
Explorer from the list of applications. Expand Computer,
right-click on the corresponding drive icon, and then select
Eject. Pull the card out of the slot.

NOTE: Never remove the card when the green LED is
flashing

After installing the media card reader and booting to Windows, the reader and the inserted cards are
not recognized by the computer.

Cause Solution

The operating system needs time to recognize the device if the Wait a few seconds so that the operating system can
reader was just installed into the computer and you are recognize the reader and the available ports, and then
turning the PC on for the first time. recognize the media inserted in the reader.

After inserting a media card in the reader, the computer attempts to boot from the media card.

Cause Solution

The inserted media card has boot capability. 1. If you do not want to boot from the media card, remove
it during boot or do not select the option to boot from the
inserfed media card during the boot process.

2. During POST (Power On Self-Test), press F9 to modify the
boot menu.

3. Change the boot sequence in F10 Computer Setup.

Solving display problems

If you encounter display problems, see the documentation that came with the monitor and to the
common causes and solutions listed in the following table.

Blank screen (no video).

Cause Solution

Monitor is not turned on and the monitor light is not on. Turn on the monitor and check that the monitor light is on.
Bad monitor. Try a different monitor.

The cable connections are not correct. Check the cable connection from the monitor to the computer

and to the electrical outlet.
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Blank screen (no video).

Cause

Solution

You may have a screen blanking utility installed or energy

saver features are enabled.

Press any key or click the mouse button and type your
password (if set).

System ROM is corrupted; system is running in Boot Block

Emergency Recovery Mode (indicated by eight beeps).

Reflash the system ROM with the latest BIOS image.

You are using a fixed-sync monitor and it will not sync at the

resolution chosen.

Be sure that the monitor can accept the same horizontal scan
rate as the resolution chosen.

Computer is in Sleep state.

Press the power button to resume from Sleep state.

CAUTION: When attempting fo resume from Sleep state,
do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you will
lose any unsaved data.

Monitor cable is plugged into the wrong connector.

Systems may have a monitor connection on both the
motherboard or an add-in card. Try moving the monitor
connection to a different connector on the back of the
computer

Monitor settings in the computer are not compatible with the

monitor.

1. In Control Panel, select Category from the View by
list, then under Appearance and Personalization,
select Adjust screen resolution.

To access Control Panel in Windows 7, click Start, and
then select Control Panel.

To access Control Panel in Windows 8, from the Start
screen, type c, and then select Control Panel from the
list of applications.

2. Expand the Resolution box, and then use the sliding
control to reset the resolution.

Monitor is configured to use an input that is not active.

Use the monitor's on-screen menu controls to select the input
that is being driven by the system. Refer to the monitor's user
documentation for more information on the on-screen controls
and seftings.

Blank screen and the power LED flashes Red five times, once every second, followed by a two second
pause, and the computer beeps five times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause

Solution

Pre-video memory error.

1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty
module.

3. Replace third-party memory with HP memory.

4. Replace the system board.
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Blank screen and the power LED flashes Red six times, once every second, followed by a two second
pause, and the computer beeps six times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause

Solution

Pre-video graphics error.

For systems with a graphics card:

1. Reseat the graphics card (if applicable). Power on the
system.

2. Replace the graphics card (if applicable).
3. Replace the system board.

For systems with integrated graphics, replace the system

board.

Blank screen and the power LED flashes Red seven times, once every second, followed by a two second
pause, and the computer beeps seven times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause

Solution

System board failure (ROM detected failure prior to video).

Replace the system board.

Monitor does not function properly when used with energy saver features.

Cause

Solution

Monitor without energy saver capabilities is being used with
energy saver features enabled.

Disable monitor energy saver feature.

Dim characters.

Cause

Solution

The brightness and contrast controls are not set properly.

Adjust the monitor brightness and contrast controls.

Cables are not properly connected.

Check that the graphics cable is securely connected to the
graphics card (if applicable) or video connector and the
monitor.

Blurry video or requested resolution cannot be set.

Cause

Solution

If the graphics controller was upgraded, the correct graphics
drivers may not be loaded.

Install the video drivers included in the upgrade kit.

Monitor is not capable of displaying requested resolution.

Change requested resolution.

Graphics card is bad.

Replace the graphics card.

Solving display problems

95



96

The picture is broken up, rolls, jitters, or flashes.

Cause

Solution

The monitor connections may be incomplete or the monitor
may be incorrectly adjusted.

1. Be sure the monitor cable is securely connected to the
computer.

2. In a two-monitor system or if another monitor is in close
proximity, be sure the monitors are not interfering with
each other’s electromagnetic field by moving them apart.

3. Fluorescent lights or fans may be too close fo the
monitor.

Monitor needs to be degaussed.

Degauss the monitor. Refer to the documentation that came
with the monitor for instructions.

Image is not centered.

Cause

Solution

Position may need adjustment.

Press the monitor's Menu button to access the OSD menu.
Select ImageControl/ Horizontal Position or Vertical
Position to adjust the horizontal or vertical position of the
image.

“No Connection, Check Signal Cable” displays on screen.

Cause

Solution

Monitor video cable is disconnected.

Connect the video cable between the monitor and computer.

CAUTION: Ensure that the computer power is off while
connecting the video cable.
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“Out of Range” displays on screen.

Cause

Solution

Video resolution and refresh rate are set higher than what the
monitor supports.

Restart the computer and enter Safe Mode. Change the
settings to a supported sefting then restart the computer so that
the new settings take effect.

To enter Safe Mode in Windows 7:

1.

2.

Restart the computer.

Press and hold the F8 key as your computer restarts,
before the Windows logo appears. If the Windows logo
appears, you must restart the computer and try again.

On the Advanced Boot Options screen, use the arrow
keys to highlight the safe mode option you want, and
then press Enter.

Log on to your computer with a user account that has
administrator rights.

When your computer is in safe mode, Safe Mode
displays in the corners of your monitor. To exit safe
mode, restart your computer and let Windows start
normally.

To enter Safe Mode in Windows 8:

Press the Windows logo + | to open the Settings charm.

Select Change PC Settings, select General, and then
under Advanced startup, click Restart now.

Select Troubleshoot, select Advanced options,
select Startup Settings, and then click Restart.

Use the function keys or number keys to select the safe
mode option you want.

When your computer is in safe mode, Safe Mode
displays in the corners of your monitor. To exit safe
mode, restart your computer and let Windows start
normally.

High pitched noise coming from inside a flat panel monitor.

Cause

Solution

Brightness and/or contrast settings are too high.

Lower brightness and/or contrast settings.
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Fuzzy focus; streaking, ghosting, or shadowing effects; horizontal scrolling lines; faint vertical bars; or
unable to center the picture on the screen (flat panel monitors using an analog VGA input connection

only).

Cause Solution

Flat panel monitor's internal digital conversion circuits may be 1. Select the monitor’s Auto-Adjustment option in the
unable to correctly interpret the output synchronization of the monitor’s on-screen display menu.

graphics card.

2. Manually synchronize the Clock and Clock Phase on-
screen display functions. To download a SoftPaq that will
assist you with the synchronization, go to the following
Web site, select the appropriate monitor, and download
either SP32347 or SP32202: http://www.hp.com
support

Graphics card is not seated properly or is bad (some models). 1. Reseat the graphics card.

2. Replace the graphics card.

Certain typed symbols do not appear correct.
Cause Solution

The font you are using does not support that particular
symbol.

Use the Character Map to locate and select the appropriate
symbol. You can copy the symbol from the Character Map
info a document.

In Windows 7, click Start, select All Programs, select
Accessories, select System Tools, and then select
Character Map.

In Windows 8, on the Start screen, type ch, and then select
Character Map from the list of applications.
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Solving audio problems

If the computer has audio features and you encounter audio problems, see the common causes and

solutions listed in the following table.

Sound cuts in and out.

Cause

Solution

Processor resources are being used by other open
applications.

Shut down all open processor-intensive applications.

Sound does not come out of the speaker or headphones.

Cause

Solution

Software volume control is turned down or muted.

Double-click the Speaker icon on the taskbar, then make
sure that Mute is not selected and use the volume slider to
adjust the volume.

NOTE: In Windows 8, the taskbar is available at the bottom
of the Desktop screen.

Audio is hidden in Computer Setup.

Enable the audio in Computer Setup: Security >
Device Security > System Audio.

The external speakers are not turned on.

Turn on the external speakers.

The audio device may be connected to the wrong jack.

Ensure that the device is connected to the correct jack on the
computer. The rear audio jack output is the green receptacle.
The speakers should be plugged info the line-out jack and the
headphones should be plugged into the headphone jack.

External speakers plugged into the wrong audio jack on a
recently installed sound card.

See the sound card documentation for proper speaker
connection. The rear audio jack output is the green
receptacle.

Headphones or devices connected to the line-out connector
mute the internal speaker.

Turn on and use headphones or external speakers, if
connected, or disconnect headphones or external speakers.

Computer is in Sleep state.

Press the power button to resume from Sleep state.

CAUTION: When attempting to resume from Sleep state,
do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you will
lose any unsaved data.

Internal speaker is disabled in Computer Setup.

Enable the internal speaker in Computer Setup. Select
Advanced > Device Options > Internal Speaker.
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Sound does not come out of the speaker or headphones.

Cause

Solution

The application is set to use a different audio device than
speakers.

Some graphics cards support audio over the DisplayPort
connection (if applicable), so multiple audio devices may be
listed in Device Manager. Make sure the correct device is
being used.

To access Device Manager in Windows 7, click Start, select
Control Panel, and then select Device Manager.

To access Device Manager in Windows 8, from the Start
screen, type c, select Control Panel from the list of
applications, and then select Device Manager.

Some applications can select which audio output device is
used.

Make sure the application has selected the correct audio
device.

The operating system controls may be set to use a different
audio device as the default output device than what is
expected.

Set the operating system to use the correct audio device.

Sound from headphones is not clear or muffled.

Cause

Solution

Headphones are plugged into the rear audio output
connector. The rear audio output connector is for powered
audio devices and is not designed for headphone use.

Plug the headphones info the headphone connector on the
front of the computer.

Computer appears to be locked up while recording audio.

Cause

Solution

The hard disk may be full.

Before recording, make sure there is enough free space on the
hard disk. You can also try recording the audio file in a
compressed format.

Line-in jack is not functioning properly.

Cause

Solution

Jack has been reconfigured in the audio driver or application
software.

In the audio driver or application software, reconfigure the
jack or set the jack to its default value.
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There is no sound or sound volume is too low.

Cause

Solution

The application is set to use a different audio device than
speakers.

Some graphics cards support audio over the DisplayPort
connection (if applicable), so multiple audio devices may be
listed in Device Manager. Make sure the correct device is
being used.

To access Device Manager in Windows 7, click Start, select
Control Panel, and then select Device Manager.

To access Device Manager in Windows 8, from the Start
screen, type c, select Control Panel from the list of
applications, and then select Device Manager.

Some applications can select which audio output device is
used.

Make sure the application has selected the correct audio
device.

The operating system controls may be set to use a different
audio device as the default output device than what is
expected.

Set the operating system to use the correct audio device.

Solving printer problems

If you encounter printer problems, see the documentation that came with the printer and to the common

causes and solutions listed in the following table.

Printer will not print.

Cause

Solution

Printer is not turned on and online.

Turn the printer on and make sure it is online.

The correct printer drivers for the application are not installed.

1. Install the correct printer driver for the application.
2. Try printing using the MS-DOS command:
DIR C:\ >

[printer port]

where [printer port] is the address of the printer being
used. If the printer works, reload the printer driver.

To run MS-DOS commands, press the Windows key + r, type
cmd in the Open box, and then click OK.

If you are on a network, you may not have made the
connection to the printer.

Make the proper network connections to the printer.

Printer may have failed.

Run printer selfest.
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Printer will not turn on.

Cause

Solution

The cables may not be connected properly.

Reconnect all cables and check the power cord and electrical
outlet.

Printer prints garbled information.

Cause

Solution

The correct printer driver for the application is not installed.

Install the correct printer driver for the application.

The cables may not be connected properly.

Reconnect all cables.

Printer memory may be overloaded.

Reset the printer by turning it off for one minute, then turn it
back on.

Printer will not print.

Cause

Solution

The printer may be out of paper.

Check the paper tray and refill it if it is empty.

Solving keyboard and mouse problems
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If you encounter keyboard or mouse problems, see the documentation that came with the equipment
and to the common causes and solutions listed in the following table.

A wireless keyboard/mouse is not working correctly. Symptoms include lagging mouse movement,
jumpy mouse/keyboard, or no function of mouse/keyboard and external drive.

Cause

Solution

If your computer is equipped with USB 3.0 ports, connected
USB 3.0 devices can interfere with the wireless keyboard USB
receiver.

Connect the wireless keyboard USB receiver to a USB 2.0
port that is separated from ports with USB 3.0 devices. If you
still experience interference, you may have to place the
connectors farther apart using an external USB hub.

Keyboard commands and typing are not recognized by the computer.

Cause

Solution

Keyboard connector is not properly connected.

Shut down the computer, reconnect the keyboard to the back
of the computer, and then restart the computer.

Program in use has stopped responding fo commands.

Shut down your computer using the mouse and then restart the
computer.
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Keyboard commands and typing are not recognized by the computer.

Cause

Solution

Keyboard needs repairs.

See the Worldwide Limited Warranty for terms and
conditions.

Computer is in Sleep state.

Press the power button to resume from Sleep state.

CAUTION: When attempting to resume from Sleep date, do
not hold down the power button for more than four seconds.
Otherwise, the computer will shut down and you will lose any
unsaved data.

Cursor will not move using the arrow keys on the keypad.

Cause

Solution

The Num Lock key is on.

Press the Num Lock key. The Num Lock light should be off if
you want to use the arrow keys on the keypad. You can
disable or enable the Num Lock key in Computer Setup at
Advanced > Device Options.

Mouse does not respond to movement or is too slow.

Cause

Solution

Mouse connector is not properly plugged into the back of the
computer.

Shut down the computer using the keyboard.
Windows 7:

1. Press the Cirl and Esc keys at the same time (or press the

Windows logo key) to display the Start menu.

2. Use the arrow keys to select Shut Down and then press
Enter.

3. After the shutdown is complete, plug the mouse
connector into the back of the computer (or the
keyboard) and restart.

Windows 8:

1. Press the Windows logo + | to open the Settings charm.

2. Use the arrow keys to select Power, and then press
Enter.

3. Use the arrow keys to select Shut Down, and then
press Enter.

4. After the shutdown is complete, plug the mouse

connector into the back of the computer (or the
keyboard) and restart.

Program in use has stopped responding to commands.

Shut down the computer using the keyboard then restart the
computer.
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Mouse does not respond to movement or is too slow.

Cause

Solution

Mouse may need cleaning.

Remove the roller ball cover on the mouse and clean the
internal components.

Mouse may need repair.

See the Worldwide Limited Warranty for terms and
conditions.

Computer is in Sleep state.

Press the power button to resume from Sleep state.

CAUTION: When attempting fo resume from Sleep state,
do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you will
lose any unsaved data.

Mouse will only move vertically, horizontally, or movement is jerky.

Cause

Solution

Mouse roller ball or the rotating encoder shafts that make
contact with the ball are dirty.

Remove roller ball cover from the bottom of the mouse and
clean the internal components with a mouse cleaning kit
available from most computer stores.

Solving Hardware Installation Problems
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You may need to reconfigure the computer when you add or remove hardware, such as an additional
drive or expansion card. If you install a plug and play device, Windows automatically recognizes the
device and configures the computer. If you install a non-plug and play device, you must reconfigure the
computer after completing installation of the new hardware. In Windows, use the Add Hardware
Wizard and follow the instructions that appear on the screen.

To open the Add Hardware Wizard, open a Command Prompt and open hdwwiz.exe.

/\ WARNING! When the computer is plugged into an AC power source, voltage is always applied to
the system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet and allow the internal system components to cool
before touching.

A new device is not recognized as part of the system.

Table E-1 Solving Hardware Installation Problems

Cause

Solution

Device is not seated or connected properly.

Ensure that the device is properly and securely connected and
that pins in the connector are not bent down.

Cable(s) of new external device are loose or power cables
are unplugged.

Ensure that all cables are properly and securely connected
and that pins in the cable or connector are not bent down.

Power switch of new external device is not turned on.

Turn off the computer, turn on the external device, then turn on
the computer to integrate the device with the computer system.
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Table E-1 Solving Hardware Installation Problems (continued)

A new device is not recognized as part of the system.

Cause

Solution

When the system advised you of changes to the configuration,
you did not accept them.

Reboot the computer and follow the instructions for accepting
the changes.

A plug and play board may not automatically configure when
added if the default configuration conflicts with other devices.

Use Windows Device Manager to deselect the automatic
settings for the board and choose a basic configuration that
does not cause a resource conflict. You can also use
Computer Setup to reconfigure or disable devices to resolve
the resource conflict.

To access Device Manager in Windows 7, click Start, select
Control Panel, and then select Device Manager.

To access Device Manager in Windows 8, from the Start
screen, type c, select Control Panel from the list of
applications, and then select Device Manager.

USB ports on the computer are disabled in Computer Setup.

Run the Computer Setup utility and ensure that Device
available is selected for appropriate USB ports under
Security > USB Security.

Computer will not start.

Cause

Solution

Wrong memory modules were used in the upgrade or
memory modules were insfalled in the wrong location.

1. Review the documentation that came with the system to
defermine if you are using the correct memory modules
and to verify the proper installation.

NOTE: DIMM1 or XMM1 must always be installed.
DIMM1 must be installed before DIMM2, and DIMM3
must be installed before DIMM4.

2. Observe the beeps and LED lights on the front of the
computer. Beeps and flashing LEDs are codes for specific
problems.

3.  If you still cannot resolve the issue, contact Customer
Support.
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Power LED flashes Red five times, once every second, followed by a two second pause, and the
computer beeps five times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Memory is installed incorrectly or is bad. CAUTION: To avoid damage to the DIMMs or the system
board, you must unplug the computer power cord before
attempting to reseat, install, or remove a DIMM module.

1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty
module.

NOTE: DIMM1 or XMM1 must always be installed.
DIMM1 must be installed before DIMM?2, and DIMM3
must be installed before DIMM4

3. Replace third-party memory with HP memory.

4. Replace the system board.

Power LED flashes Red six times, once every second, followed by a two second pause, and the computer
beeps six times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Graphics card (some models) is not seated properly or is bad,  For systems with a graphics card:

or system board is bad.
1. Reseat the graphics card. Power on the system.
2. Replace the graphics card.
3. Replace the system board.

For systems with integrated graphics, replace the system

board.

Power LED flashes Red ten times, once every second, followed by a two second pause, and the computer
beeps ten times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Bad option card. 1. Check each option card by removing the cards one at
time (if multiple cards), then power on the system to see if
fault goes away.

2. Once bad card is identified, remove and replace bad
option card.

3. Replace the system board.
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Solving Network Problems

Some common causes and solutions for network problems are listed in the following table. These
guidelines do not discuss the process of debugging the network cabling.

Table E-2 Solving Network Problems

Wake-on-LAN feature is not functioning.

Cause Solution

S5 Maximum Power Saving feature is enabled. Disable the S5 Maximum Power Saving option in Computer
Setup. Select Power > Hardware Power Management
> S$5 Maximum Power Savings.

S5 Wake on LAN is disabled (some models). Enable the S5 Wake on LAN option in Computer Setup.
Select Advanced > Device Options > S5 Wake on
LAN.

Woake-on-LAN is not enabled. To enable Wake-on-LAN in Windows 7:

1. Select Start > Control Panel > Network and
Sharing Center.

2. Under Tasks, select Manage network
connections.

3. Click Local Area Connection.
4. Click the Properties button.
5. Click the Configure button.

6. Click the Power Management tab, then select
Allow this device to wake the computer.

To enable Wake-on-LAN in Windows 8:

1. From the Start screen, type c, and then select Control
Panel from the list of applications.

2. Select Network and Sharing Center, and then click
the Ethernet link next to the connection.

3. Click the Properties button.
4. Click the Configure button.

5. Click the Power Management tab, then enable the
appropriate Wake-on LAN option.
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Network driver does not detect network controller.

Cause

Solution

Network controller is disabled.

1.

2.

Run Computer Setup and enable network controller.

Enable the network controller in the operating system
using Device Manager.

To access Device Manager in Windows 7, click Start,
select Control Panel, and then select Device
Manager.

To access Device Manager in Windows 8, from the Start
screen, type c, select Control Panel from the list of
applications, and then select Device Manager.

Incorrect network driver.

Check the network controller documentation for the correct
driver or obtain the latest driver from the manufacturer's Web

site.

Network status link light never flashes.

NOTE: The network status light is supposed to flash when there is network activity.

Cause

Solution

No active network is detected.

Check cabling and network equipment for proper connection.

Network controller is not set up properly.

Check for the device status within Windows, such as Device
Manager for driver load and the Network Connections applet
within Windows for link status.

To access Device Manager in Windows 7, click Start, select
Control Panel, and then select Device Manager.

To access Device Manager in Windows 8, from the Start
screen, type c, select Control Panel from the list of
applications, and then select Device Manager.

Network controller is disabled.

1.

2,

Run Computer Setup and enable network controller.

Enable the network controller in the operating system
using Device Manager.

To access Device Manager in Windows 7, click Start,
select Control Panel, and then select Device
Manager.

To access Device Manager in Windows 8, from the Start
screen, type c, select Control Panel from the list of
applications, and then select Device Manager.

Network driver is not properly loaded.

Reinstall network drivers.

System cannot autosense the network.

Disable auto-sensing capabilities and force the system into the
correct operating mode.
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Diagnostics reports a failure.

Cause

Solution

The cable is not securely connected.

Ensure that the cable is securely attached to the network
connector and that the other end of the cable is securely
attached to the correct device.

The cable is attached to the incorrect connector.

Ensure that the cable is attached to the correct connector.

There is a problem with the cable or a device at the other end
of the cable.

Ensure that the cable and device at the other end are
operating correcily.

Network controller interrupt is shared with an expansion

board.

Under the Computer Setup Advanced menu, change the
resource settings for the board.

The network controller is defective.

Contact an authorized service provider.

Diagnostics passes, but the computer does not communicate with the network.

Cause

Solution

Network drivers are not loaded, or driver parameters do not
match current configuration.

Make sure the network drivers are loaded and that the driver
parameters match the configuration of the network controller.

Make sure the correct network client and protocol is installed.

The network controller is not configured for this computer.

Select the Network and Sharing Center icon in the
Control Panel and configure the network controller.

To access Control Panel in Windows 7, click Start, and then
select Control Panel.

To access Control Panel in Windows 8, from the Start screen,
type ¢, and then select Control Panel.

Network controller stopped working when an expansion board was added to the computer.

Cause

Solution

Network controller interrupt is shared with an expansion

board.

Under the Computer Setup Advanced menu, change the
resource settings for the board.

The network controller requires drivers.

Verify that the drivers were not accidentally deleted when the
drivers for a new expansion board were installed.

The expansion board installed is a network card (NIC) and
conflicts with the embedded NIC.

Under the Computer Setup Advanced menu, change the
resource settings for the board.
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Network controller stops working without apparent cause.

Cause Solution

The files containing the network drivers are corrupted. Reinstall the network drivers using the Recovery Disc Set in
Windows 7 or Windows recovery fools in Windows 8.

If necessary, download the softpaq from the web (from a
different computer).

The cable is not securely connected. Ensure that the cable is securely attached to the network
connector and that the other end of the cable is securely
attached to the correct device.

The network controller is defective. Contact an authorized service provider.

New network card will not boot.

Cause Solution

New network card may be defective or may not meet industry-  Install a working, industry-standard NIC, or change the boot
standard specifications. sequence fo boot from another source.

Cannot connect to network server when attempting Remote System Installation.

Cause Solution

The network controller is not configured properly. Verify Network Connectivity, that a DHCP Server is present,
and that the Remote System Installation Server contains the
NIC drivers for your NIC.

System setup utility reports unprogrammed EEPROM.

Cause Solution

Unprogrammed EEPROM. Contact an authorized service provider.

Solving memory problems
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If you encounter memory problems, some common causes and solutions are listed in the following
table.

/\ CAUTION: Power may still be supplied to the DIMMs when the computer is turned off (depending on
the Management Engine (ME) settings). To avoid damage to the DIMMs or the system board, you must
unplug the computer power cord before attempting to reseat, install, or remove a memory module.

For those systems that support ECC memory, HP does not support mixing ECC and non-ECC memory.
Otherwise, the computer will not boot the operating system.
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E‘%NOTE: The memory count will be affected by configurations with the Management Engine (ME)
enabled. The ME uses 8MB of system memory in single channel mode or 16MB of memory in dual-
channel mode to download, decompress, and execute the ME firmware for Out-of-Band (OOB), third-
party data storage, and other management functions.

System will not boot or does not function properly after installing additional memory modules.

Cause

Solution

A memory module is not installed in the DIMM1 or XMM1
socket.

Ensure that a memory module is installed in the DIMM1 or
XMM1 socket on the system board. This socket must be
populated with a memory module.

Memory module is not the correct type or speed grade for the
system or the new memory module is not seated properly.

Replace module with the correct industry-standard device for
the computer. On some models, ECC and non-ECC memory
modules cannot be mixed.

Out of memory error.

Cause

Solution

You have run out of memory to run the application.

Check the application documentation to determine the
memory requirements.

Memory count during POST is wrong.

Cause

Solution

The memory modules may not be installed correctly.

Check that the memory modules have been installed correctly
and that proper modules are used.

Integrated graphics may use system memory.

No action required.

Insufficient memory error during operation.

Cause

Solution

Too many Terminate and Stay Resident programs (TSRs) are
installed.

Delete any TSRs that you do not need.

You have run out of memory for the application.

Check the memory requirements for the application or add
more memory to the computer.
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Power LED flashes Red five times, once every second, followed by a two second pause, and the
computer beeps five times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Memory is installed incorrectly or is bad. 1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty
module.

3. Replace third-party memory with HP memory.

4. Replace the system board.

Solving processor problems
If you encounter processor problems, common causes and solutions are listed in the following table.

Poor performance is experienced.

Cause Solution

Processor is hot. 1. Make sure the airflow to the computer is not blocked.

2. Make sure the fans are connected and working properly
(some fans only operate when needed).

3. Make sure the processor heat sink is installed properly.

Power LED flashes Red three times, once every second, followed by a two second pause.

Cause Solution

Processor is not seated properly or not installed. 1. Check to see that the processor is present.

2. Reseat the processor.

Power LED flashes Red eleven times, once every second, followed by a two second pause.

Cause Solution
The current processor does not support a feature previously 1. |Install a TXT (Trusted Execution Technology) capable
enabled on this system. processor.

2. Disable TXT in the Computer Setup (F10) utility.

3. Reinstall the original processor.
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Solving CD-ROM and DVD problems

If you encounter CD-ROM or DVD problems, see the common causes and solutions listed in the
following table or to the documentation that came with the optional device.

System will not boot from CD-ROM or DVD drive.

Cause

Solution

The device is attached to a SATA port that has been hidden in
the Computer Setup utility.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Removable Media Boot is disabled in the Computer Setup
utility.

Run the Computer Setup utility and enable booting to
removable media in Storage > Storage Options. Ensure
CD-ROM is enabled in Storage > Boot Order.

Network Boot is enabled in Computer Setup.

Run the Computer Setup utility and disable Network Boot in
Security > Network Boot.

Non-bootable CD in drive.

Try a bootable CD in the drive.

Boot order not correct.

Run the Computer Setup utility and change boot sequence in
Storage > Boot Order.

Drive not found (identified).

Cause

Solution

Cable could be loose.

Check cable connections.

The system may not have automatically recognized a newly
installed device.

See reconfiguration directions in the Solving Hardware
Installation Problems on page 104 section. If the system still
does not recognize the new device, check fo see if the device
is listed within Computer Setup. If it is listed, the probable
cause is a driver problem. If it is not listed, the probable cause
is a hardware problem.

If this is a newly installed drive, run the Computer Setup utility
and try adding a POST delay under Advanced > Power-
On Options.

The device is attached to a SATA port that has been hidden in
Computer Setup.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Drive responds slowly immediately after power-up.

Run Computer Setup and increase the POST Delay in
Advanced > Power-On Options.

CD-ROM or DVD devices are not detected or driver is not loaded.

Cause

Solution

Drive is not connected properly or not properly configured.

See the documentation that came with the optional device.

Solving CD-ROM and DVD problems

113



Movie will not play in the DVD drive.

Cause Solution

Movie may be regionalized for a different country. See the documentation that came with the DVD drive.
Decoder software is not installed. Install decoder software.

Damaged media. Replace media.

Movie rating locked out by parental lock. Use DVD software to remove parental lock.

Media installed upside down. Reinstall media.

Cannot eject compact disc (tray-load unit).

Cause Solution

Disc not properly seated in the drive. Turn off the computer and insert a thin metal rod into the
emergency eject hole and push firmly. Slowly pull the tray out
from the drive until the tray is fully extended, then remove
the disc.

CD-ROM, CD-RW, DVD-ROM, or DVD-R/RW drive cannot read a disc or takes too long to start.

Cause Solution

Media is corrupt. Try different media to confirm whether media is valid.

Media has been inserted upside down. Re-insert the media with the label facing up.

The DVD-ROM drive takes longer to start because it has to Wait at least 30 seconds fo let the DVD-ROM drive determine
determine the type of media played, such as audio or video.  the type of media being played. If the disc still does not start,

read the other solutions listed for this topic.

CD or DVD disc is dirty. Clean CD or DVD with a CD cleaning kit, available from most
computer stores.

Windows does not detect the CD-ROM or DVD-ROM drive. 1. Use Device Manager fo remove or uninstall the device.

To access Device Manager in Windows 7, click Start,
select Control Panel, and then select Device
Manager.

To access Device Manager in Windows 8, from the Start
screen, type c, select Control Panel from the list of
applications, and then select Device Manager.

2. Restart the computer and let Windows detect the CD or
DVD driver.
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Recording or copying CDs is difficult or impossible.

Cause Solution

Wrong or poor quality media type. 1. Try using a slower speed when recording.
2. Verify that you are using the correct media for the drive.

3. Try a different brand of media. Quality varies widely
between manufacturers.

Solving USB flash drive problems

If you encounter USB flash drive problems, common causes and solutions are listed in the following
table.

USB flash drive is not seen as a drive letter in Windows.

Cause Solution

The drive letter after the last physical drive is not available. Change the default drive letter for the flash drive in Windows.

USB flash drive not found (identified).

Cause Solution

The device is aftached to a USB port that has been hidden in Run the Computer Setup utility and enable USB ports in
Computer Setup. Security > USB Security.

The device was not properly seated before power-up. Ensure the device is fully inserted into the USB port before
applying power to the system

System will not boot from USB flash drive.

Cause Solution

Boot order is not correct. Run the Computer Setup utility and change boot sequence in
Storage > Boot Order.

Removable Media Boot is disabled in the Computer Setup Run the Computer Setup utility and enable booting to
utility. removable media in Storage > Storage Options. Ensure
USB is enabled in Storage > Boot Order.

The computer boots to DOS after making a bootable flash drive.

Cause Solution
Flash drive is bootable. Install the flash drive only after the operating system boots.
Flash drive is defective. Try a different flash drive.
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Solving front panel component problems

If you encounter problems with devices connected to the front panel, refer to the common causes and

solutions listed in the following table.

A USB device, headphone, or microphone is not recognized by the computer.

Cause

Solution

Device is not properly connected.

1.  Turn off the computer.

2. Reconnect the device to the front of the computer and
restart the computer.

The device does not have power.

If the USB device requires AC power, be sure one end is
connected to the device and one end is connected to a live
outlet.

The correct device driver is not installed.

1. Install the correct driver for the device.

2. You might need to reboot the computer.

The cable from the device to the computer does not work.

1. |If possible, replace the cable.

2. Restart the computer.

The device is not working.

1. Replace the device.

2. Restart the computer.

USB ports on the computer are disabled in Computer Setup.

Run the Computer Setup utility and ensure that the USB ports
are set to Enabled in Security > USB Security.

Solving Internet access problems
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If you encounter Internet access problems, consult your Internet Service Provider (ISP) or refer to the
common causes and solutions listed in the following table.

Unable to connect to the Internet.

Cause

Solution

Internet Service Provider (ISP) account is not set up properly.

Verify Internet seftings or contact your ISP for assistance.

Web browser is not set up properly.

Verify that the Web browser is installed and set up to work
with your ISP.

Cable/DSL modem is not plugged in.

Plug in cable/DSL modem. You should see a “power” LED
light on the front of the cable/DSL modem.

Cable/DSL service is not available or has been interrupted
due to bad weather.

Try connecting to the Internet at a later time or contact your
ISP. (If the cable/DSL service is connected, the “cable” LED
light on the front of the cable/DSL modem will be on.)
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Unable to connect to the Internet.

Cause

Solution

The CAT5 UTP cable is disconnected.

Connect the CAT5 UTP cable between the cable modem and
the computers’s RJ-45 connector. (If the connection is good,
the “PC” LED light on the front of the cable/DSL modem will
be on.)

IP address is not configured properly.

Contact your ISP for the correct IP address.

Cookies are corrupted. (A “cookie” is a small piece of
information that a Web server can store temporarily with the
Web browser. This is useful for having the browser remember
some specific information that the Web server can later
retrieve.)

Windows 7:
1. Select Start > Control Panel.
2. Click Internet Options.

3. In the Browsing history section on the General tab,
click the Delete button.

4. Select the Cookies check box and click the Delete
button.

Windows 8:

1. From the Start screen, type c, and then select Control
Panel from the list of applications..

2. Click Internet Options.

3. In the Browsing history section on the General tab,
click the Delete button.

4. Select the Cookies check box and click the Delete
button.

Cannot automatically launch Internet programs.

Cause

Solution

You must log on to your ISP before some programs will start.

Log on to your ISP and launch the desired program.

Solving Internet access problems
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Solving software problems

Most software problems occur as a result of the following:

e The application was not installed or configured correctly.

e  There is insufficient memory available to run the application.
e There is a conflict between applications.

e  Be sure that all the needed device drivers have been installed.

e If you have installed an operating system other than the factory-installed operating system, check
to be sure it is supported on the system.

If you encounter software problems, see the applicable solutions listed in the following table.

Computer will not continue and the HP logo does not display.

Cause Solution

ROM issue - POST error has occurred. Observe the beeps and LED lights on the front of the
computer. See Appendix A, POST Error Messages
on page 68 to determine possible causes.

See the Worldwide Limited Warranty for terms and
conditions.
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Computer will not continue after HP logo screen displays.

Cause

Solution

System files may be damaged.

In Windows 7, use recovery media to scan hard drive for
errors, or use Windows Startup Repair to fix problems that
might prevent Windows from starting correctly. Windows
Startup Repair is one of the recovery tools in the System
Recovery Options menu. You can also create a system repair
disc that contains the System Recovery Options menu. If the
problem is severe enough that Startup Repair doesn't start on
its own and you can't access the System Recovery Options
menu on your computer's hard disk, you can get to the menu
and start Startup Repair by using the Windows installation
disc or a system repair disc that you created earlier.

In Windows 8, use Automatic Repair to fix problems that
might prevent Windows from starting correctly.

To access Automatic Repair:
1. Press the Windows logo + | to open the Seftings charm.

2. Select Change PC Settings, select General, and then
under Advanced startup, click Restart now.

3. Select Troubleshoot, select Advanced options, and
then select Automatic Repair.

Windows starts Automatic Repair.

4. Select the account to use to begin Automatic Repair, and
type the password for the account.

Windows diagnoses the computer and attempts the
repair it.

“lllegal Operation has Occurred” error message is displayed.

Cause

Solution

Software being used is not Microsoft-certified for your version
of Windows.

Verify that the software is certified by Microsoft for your
version of Windows (see program packaging for this
information).

Configuration files are corrupt.

If possible, save all data, close all programs, and restart the
computer.
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HP PC Hardware Diagnostics

To help troubleshoot and diagnose failures, use the UEFI-based hardware diagnostic solution that HP
includes on all products. This tool can even be used if the computer will not boot to the operating
system.

Why run HP PC Hardware Diagnostics

The HP PC Hardware Diagnostic tools simplify the process of diagnosing hardware issues and expedite
the support process when issues are found. The tools save time by pinpointing the component that
needs to be replaced.

e Isolate true hardware failures: The diagnostics run outside of the operating system so they
effectively isolate hardware failures from issues that may be caused by the operating system or
other software components.

e Failure ID: When a failure is detected that requires hardware replacement, a 24-digit Failure ID
is generated. This ID can then be provided to the call agent, who will either schedule support or
provide replacement parts.

How to access and run HP PC Hardware Diagnostics
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You can run the diagnostics from one of three places, depending on your preference and the health of
the computer.

1. Turn on the computer and press Esc repeatedly until the BIOS Boot Menu appears.
2. Press F2 or select Diagnostics (F2).
Pressing F2 signals the system to search for the diagnostics in the following locations:

a. A connected USB drive (to download the diagnostics tools to a USB drive, see the instructions
in Downloading HP PC Hardware Diagnostics to a USB device on page 121).

b. The hard disk drive.

c. A core set of diagnostics in the BIOS (for memory and hard disk drive) that are accessible
only if the USB or hard disk drive versions are not detected.
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Downloading HP PC Hardware Diagnostics to a USB
device
There are two options to download HP PC Hardward Diagnostics to USB device.

Option 1: HP PC Diagnostics homepage-Provides access to the latest UEFI version.

1. Go to http://www.hp.com.

2. Click the UEFI Dowload link, and then select Run.

Option 2: Support and Drivers pages-Provides downloads for a specific product for earlier and
later versions.

1. Go to http://www.hp.com.

2. Point to Support, located at the top of the page, and then clickDownload Drivers.
3. In the text box, enter the product name, and then click Go.
—or—
Click Find Now to let HP automatically detect your product.
4. Select your computer model, and then select your operating system.
5. In the Diagnostic section, click HP UEFI Support Environment.

6. Click Download, and then select Run.
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G System backup and recovery

Backing up, restoring, and recovering in Windows
8.1 or Windows 8

Your computer includes tools provided by HP and Windows to help you safeguard your information
and retrieve it if you ever need to. These tools will help you return your computer to a proper working
state or even back to the original factory state, all with simple steps.

This section provides information about the following processes:
e  Creating recovery media and backups

e  Restoring and recovering your system

2»NOTE: This section describes an overview of backing up, restoring, and recovering options. For more
details about the tools provided, see Help and Support. From the Start screen, type help, and then
select Help and Support.

Creating recovery media and backups

Recovery after a system failure is only as good as your most recent backup.

1. After you successfully set up the computer, create recovery media. This step creates a backup of
the recovery partition on the computer. The backup can be used to reinstall the original operating
system in cases where the hard drive is corrupted or has been replaced.

You will use a USB flash drive to create a bootable recovery drive that can be used to troubleshoot
a computer that is unable to start. The USB flash drive can be used to reinstall the original
operating system and the programs that were installed at the factory.
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2»NOTE: Any information on the USB flash drive will be erased before the recovery media is
created.

e To create the Windows 8.1 recovery media, from the Start screen, type recovery drive,
then click on Create a recovery drive. Follow the on-screen instructions to continue.

e To create the Windows 8 recovery media, from the Start screen, type recovery drive,
and then click on Settings, then click on Create a recovery drive. Follow the on-screen
instructions to continue.

2. Use the Windows tools to create system restore points and create backups of personal
information. For more information and steps, see Help and Support. From the Start screen, type
help, and then select Help and Support.

Restoring and recovering using Windows tools
Windows offers several options for restoring from backup, refreshing the computer, and resetting the

computer to its original state. For more information and steps, see Help and Support. From the Start
screen, type help, and then select Help and Support.

Using Reset when the system is not responding

E/%"NOTE: You may be prompted by User Account Control for your permission or password when you
perform certain tasks. To continue a task, select the appropriate option. For information about User
Account Control, see Help and Support. From the Start screen, type help, and then select Help and
Support.

@IMPORTANT: Reset does not provide backups of your information. Before using Reset, back up any
personal information you wish to retain.

If Windows recovery steps are not working and the system is not responding, use these steps to start
Reset:

1. If possible, back up all personal files.
2. |If possible, check for the presence of the HP Recovery partition:
e For Windows 8.1, from the Start screen, type pc, and then select This PC.

e  For Windows 8, from the Start screen, type c, and then select Computer.

%%NOTE: If the HP Recovery partition is not listed, or you cannot check for its presence, you must
recover using the recovery media you created; see Recovery using the Windows recovery USB
flash drive on page 124. Or you must use the Windows operating system media and the Driver
Recovery media (purchased separately); see Recovery using Windows operating system media
(purchased separately) on page 124.

3. If the HP Recovery partition is listed, restart the computer, and then press esc while the HP logo is
displayed. The computer Startup Menu displays.

4. Press {11 to select the System Recovery option.

5. Choose your keyboard layout.
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6. Select Troubleshoot.
7. Select Reset.

8. Follow the on-screen instructions to continue.

Recovery using the Windows recovery USB flash drive

To recover your system using the recovery USB flash drive you previously created:

@NOTE: If you did not create a recovery USB flash drive or the one you created does not work, see
Recovery using Windows operating system media (purchased separately) on page 124.

-
.

If possible, back up all personal files.
2. Insert the recovery USB flash drive you created into a USB port on your computer.

3. Restart the computer and as soon as you see the HP logo screen, press {9 to display a list of boot
devices. Use the arrow keys to select your USB flash drive from the UEFI Boot Sources list. Press
Enter to boot from that device.

4. Choose your keyboard layout.
5. Select Troubleshoot.

6. Select Refresh your PC.
7

Follow the on-screen instructions.

Recovery using Windows operating system media (purchased separately)

To order a Windows operating system DVD, contact support. Go to http://www.hp.com/support,
select your country or region, and follow the on-screen instructions.

/\ CAUTION: Using Windows operating system media completely erases the hard drive contents and
reformats the hard drive. All files that you have created and any software that you have installed on the
computer are permanently removed. When reformatting is complete, the recovery process helps you
restore the operating system, as well as drivers, software, and utilities.

To initiate recovery using Windows operating system media:

@NOTE: This process takes several minutes.

1. |If possible, back up all personal files.

2. Restart the computer, and then follow the instructions provided with the Windows operating system
media to install the operating system.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.
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Atter the repair is completed and the Windows desktop appears:
1. Remove the Windows operating system media, and then insert the Driver Recovery media.

2. |Install the Hardware Enabling Drivers first, and then install Recommended Applications.

Backing up, restoring, and recovering in Windows 7

Your computer includes tools provided by HP and Windows to help you safeguard your information
and retrieve it if you ever need to. These tools will help you return your computer to a proper working
state or even back to the original factory state, all with simple steps.

This section provides information about the following processes:
e  Creating recovery media and backups

e  Restoring and recovering your system

2 NOTE: This section describes an overview of backing up, restoring, and recovering options. For more
details about the Windows Backup and Restore tools provided, see Help and Support. To access Help
and Support, select Start > Help and Support.

Recovery after a system failure is only as good as your most recent backup.

1. After you successtully set up the computer, create recovery media. This media can be used to
reinstall the original operating system in cases where the hard drive is corrupted or has been
replaced. See Creating recovery media on page 125.

2. As you add hardware and software programs, create system restore points. A system restore point
is a snapshot of certain hard drive contents saved by Windows System Restore at a specific time.
A system restore point contains information that Windows uses, such as registry settings. Windows
creates a system restore point for you automatically during a Windows update and during other
system maintenance (such as a software update, security scanning, or system diagnostics). You
can also manually create a system restore point at any time. For more information and steps for
creating specific system restore points, see Help and Support. To access Help and Support, select
Start > Help and Support.

3. As you add photos, video, music, and other personal files, create a backup of your personal
information. If files are accidentally deleted from the hard drive and they can no longer be
restored from the Recycle Bin, or if files become corrupted, you can restore the files that you
backed up. In case of system failure, you can use the backup files to restore the contents of your
computer. See Backing up your information on page 128.

2 NOTE: HP recommends that you print the recovery procedures and save them for later use, in case of
system instability.

Creating recovery media

After you successfully set up the computer, create recovery media. The media can be used to reinstall
the original operating system in cases where the hard drive is corrupted or has been replaced.
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There are two types of recovery media. To determine which steps to follow for your computer:
1. Click the Start button.

2. Click All Programs.

e If Security and Protection is listed, continue with the steps in Creating recovery media
using HP Recovery Manager (select models only) on page 126.

e If Productivity and Tools is listed, continue with the steps in Creating recovery discs with
HP Recovery Disc Creator (select models only) on page 127.

Creating recovery media using HP Recovery Manager (select models only)

e To create recovery discs, your computer must have a DVD writer. Use DVD+R or DVD-R discs
(purchased separately). The discs you use will depend on the type of optical drive you are using.

E%?NOTE: DVD+R DL, DVD-R DL, or DVD+RW disc are not supported.

e  You have the option of creating a recovery USB flash drive instead, using a high-quality USB
drive.

e If you are creating recovery discs, be sure to use high-quality discs. It is normal for the system to
reject defective discs. You will be prompted to insert a new blank disc to try again.

e  The number of discs in the recovery-disc set depends on your computer model (typically 3 to 6
DVDs). The Recovery Media Creation program fells you the specific number of blank discs needed
to make the set. If you are using a USB flash drive, the program will tell you the size of the drive
required to store all the data (minimum of 8 GB).

2 NOTE: The process of creating recovery media is lengthy. You can quit the process at any time.
The next time you initiate the process, it resumes where it left off.

2»NOTE: Do not use media cards for creating recovery media. The system may not be able to boot up
from a media card and you may not be able to run system recovery.

To create recovery discs:
1. Close all open programs.

2. Click the Start button, click All Programs, click Security and Protection, click Recovery
Manager, and then click HP Recovery Media Creation. If prompted, click Yes to allow the
program to continue.

3. Click Create recovery media using blank DVD(s), and then click Next.

4. Follow the on-screen instructions. Label each disc after you make it (for example, Recovery 1,
Recovery 2), and then store the discs in a secure place.

To create a recovery USB flash drive:

@NOTE: You must use a USB flash drive with a capacity of at least 8 GB.
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E’%NOTE: Recovery Media Creation formats the USB flash drive, deleting any files on it.

1. Close all open programs.
2. Insert the USB flash drive into a USB port on the computer.

3. Click the Start button, click All Programs, click Security and Protection, click Recovery
Manager, and then click Recovery Media Creation.

4. Click Create recovery media with a USB flash drive, and then click Next.

5. Select the USB flash drive from the list of media. The program will let you know how much storage
is required to create the recovery drive. If the USB flash drive does not have enough storage
capacity, it will appear grayed out, and you must replace it with a larger USB flash drive. Click
Next.

6. Follow the on-screen instructions. When the process is complete, label the USB flash drive and
store it in a secure place.

Creating recovery discs with HP Recovery Disc Creator (select models only)

HP Recovery Disc Creator is a software program that offers an alternative way to create recovery discs
on select models. After you successtully set up the computer, you can create recovery discs using HP
Recovery Disc Creator. The recovery discs allow you to reinstall your original operating system as well
as select drivers and applications if the hard drive becomes corrupted. HP Recovery Disc Creator
creates two kinds of recovery discs:

e  Windows 7 operating system DVD—Installs the operating system without additional drivers or
applications.

o  Driver Recovery DVD—Installs specific drivers and applications only, in the same way that the HP
Software Setup utility installs drivers and applications.

To create recovery discs, your computer must have a DVD writer. Use any of the following types of
discs (purchased separately): DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD+RW. The discs you use
will depend on the type of optical drive you are using.

Creating recovery discs

=»NOTE: The Windows 7 operating system DVD can be created only once. The option to create that
media will not be available after you create a Windows DVD.

To create the Windows DVD:

1. Select Start > All Programs > Productivity and Tools > HP Recovery Disc Creator.
2. Select Windows disk.

3. From the drop-down menu, select the drive for burning the recovery media.

4

Click the Create button to start the burning process. Label the disc after you create it, and store it
in a secure place.

Backing up, restoring, and recovering in Windows 7 127



After the Windows 7 operating system DVD has been created, create the Driver Recovery DVD:

1.

Lol S

Select Start > All Programs > Productivity and Tools > HP Recovery Disc Creator.
Select Driver disk.
From the drop-down menu, select the drive for burning the recovery media.

Click the Create button to start the burning process. Label the disc after you create it, and store it
in a secure place.

Backing up your information

You should create your initial backup immediately after initial system setup. As you add new software
and data files, you should continue to back up your system on a regular basis to maintain a reasonably
current backup. Your initial and subsequent backups allow you to restore your data and settings if a
failure occurs.

You can back up your information to an optional external hard drive, a network drive, or discs.

Note the following when backing up:

Store personal files in the Documents library, and back it up regularly.
Back up templates that are stored in their associated directories.

Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

When backing up to discs, number each disc after removing it from the drive.

2 NOTE: For detailed instructions on various backup and restore options, perform a search for these
topics in Help and Support. To access Help and Support, select Start > Help and Support.

@NOTE: You may be prompted by User Account Control for your permission or password when you
perform certain tasks. To continue a task, select the appropriate option. For information about User
Account Control, see Help and Support: Select Start > Help and Support.

To create a backup using Windows Backup and Restore:

@NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1.
2,

Select Start > All Programs > Maintenance > Backup and Restore.

Follow the on-screen instructions to set up your backup.

System Restore

128

If you have a problem that might be due to software that you installed on your computer, or if you want
to restore the system to a previous state without losing any personal information, use System Restore to
return the computer to a previous restore point.

@NOTE: Always use this System Restore procedure before you use the System Recovery feature.
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To start System Restore:

1. Close all open programs.

2. Click the Start button, right-click Computer, and then click Properties.

3. Click System protection, System Restore, click Next, and then follow the on-screen

instructions.

System Recovery

/A WARNING! This procedure will delete all user information. To prevent loss of information, be sure to
back up all user information so you can restore it after recovery.

System Recovery completely erases and reformats the hard disk drive, deleting all data files that you
have created, and then reinstalls the operating system, programs, and drivers. However, you must
reinstall any software that was not installed on the computer at the factory. This includes software that
came on media included in the computer accessory box, and any software programs you installed after
purchase. Any personal files must be restored from backups you made.

If you were not able to create system recovery DVDs or USB flash drive, you can order a recovery disc
set from support. Go to http://www.hp.com/support, select your country or region, and follow the on-
screen instructions.

r__":"/rNOTE: Always use the System Restore procedure before you use the System Recovery program. See
System Restore on page 128.

You must choose one of the following methods to perform a System Recovery:

e Recovery image — Run System Recovery from a recovery image stored on your hard disk drive.
The recovery image is a file that contains a copy of the original factory-shipped software. To
perform a System Recovery from a recovery image, see System Recovery when Windows is
responding on page 129 or System Recovery when Windows is not responding on page 130.

e Recovery media — Run System Recovery from recovery media that you have created from files
stored on your hard disk drive or purchased separately. See System Recovery using recovery
media (select models only) on page 130.

System Recovery when Windows is responding

/\ CAUTION: System Recovery deletes all data and programs you created or installed. Before you
begin, back up any important data to a CD or DVD or to a USB flash drive.

2 NOTE: In some cases, you must use recovery media for this procedure. If you have not already
created this media, follow the instructions in Creating recovery media on page 125.

If the computer is working and Windows 7 is responding, use these steps o perform a System
Recovery:

1. Turn off the computer.
2. Disconnect all peripheral devices from the computer except the monitor, keyboard, and mouse.

3. Turn on the computer.
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When Windows has loaded, click the Start button, and then click All Programs.
e If Security and Protection is listed, continue with step 5.

e If Productivity and Tools is listed, follow the steps in System Recovery when Windows is
not responding on page 130.

Click Security and Protection, click Recovery Manager, and then click Recovery
Manager. If prompted, click Yes to allow the program to continue.

Under | need help immediately, click System Recovery.
Select Yes, and then click Next. Your computer restarts.

When the computer restarts, you will see the Recovery Manager welcome screen again. Under |
need help immediately, click System Recovery. If you are prompted to back up your files,
and you have not done so, select Back up your files first (recommended), and then click
Next. Otherwise, select Recover without backing up your files, and then click Next.

System Recovery begins. After System Recovery is complete, click Finish to restart the computer.

When Windows has loaded, shut down the computer, reconnect all peripheral devices, and then
turn the computer back on.

System Recovery when Windows is not responding

/\ CAUTION: System Recovery deletes all data and programs you created or installed.

If Windows is not responding, but the computer is working, follow these steps to perform a System

Recovery.

1. Turn off the computer. If necessary, press and hold the power button until the computer turns off.

2. Disconnect all peripheral devices from the computer, except the monitor, keyboard, and mouse.

3. Press the power button to turn on the computer.

4. As soon as you see the HP logo screen, repeatedly press the F11 key on your keyboard until the
Windows is loading Files... message appears on the screen.

5. At the HP Recovery Manager screen, follow the on-screen instructions to continue.

6. When Windows has loaded, shut down the computer, reconnect all peripheral devices, and then

turn the computer back on.

System Recovery using recovery media (select models only)

130

Use the steps provided in this section if you created recovery media using Creating recovery media
using HP Recovery Manager (select models only) on page 126. If you used HP Recovery Disc Creator

to create a Windows 7 operating system DVD and a Driver Recovery DVD, use the steps in Using HP
Recovery Disc operating system discs (select models only) on page 131.

/\ CAUTION: System Recovery deletes all data and programs you have created or installed. Back up
any important data to a CD or DVD or to a USB flash drive.
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To perform a System Recovery using recovery media:

1. If you are using a set of DVDs, insert the first recovery disc into the DVD drive tray, and close the
tray. If you are using a recovery USB flash drive, insert it into a USB port.

2. Click the Start button, and then click Shut Down.
or

If the computer is not responding, press and hold the power button for approximately 5 seconds or
until the computer turns off.

3. Disconnect all peripheral devices from the computer except the monitor, keyboard, and mouse.

4. Press the power button to turn on the computer, and press Esc as the computer is powering on to
display the startup menu.

5. Use the arrow keys to select the boot menu, and press Enter. Use the arrow keys to select the
location where the recovery media is inserted (USB or DVD). Press Enter to boot from that device.

6. If Recovery Manager asks if you want to run System Recovery from Media or Hard Drive, select
Media. On the Welcome screen, under | need help immediately, click Factory Reset.

7. If you are prompted to back up your files, and you have not done so, select Back up your files
first (recommended), and then click Next. Otherwise, select Recover without backing
up your files, and then click Next.

8. If you are prompted to insert the next recovery disc, do so.

9. When Recovery Manager is finished, remove the recovery disc or the recovery USB flash drive
from the system.

10. Click Finish to restart the computer.

Using HP Recovery Disc operating system discs (select models only)

Use the steps provided in this section if you used HP Recovery Disc Creator to create a Windows 7
operating system DVD and a Driver Recovery DVD. If you created recovery media using Creating
recovery media using HP Recovery Manager (select models only) on page 126. use the steps in System
Recovery using recovery media (select models only) on page 130.

If you cannot use the recovery discs you previously created using the HP Recovery Disc Creator (select
models only), you must purchase a Windows 7 operating system DVD to reboot the computer and
repair the operating system.

To order a Windows 7 operating system DVD, contact support. Go to hitp://www.hp.com/support,
select your country or region, and follow the on-screen instructions.

/\ CAUTION: Using a Windows 7 operating system DVD completely erases the hard drive contents
and reformats the hard drive. All files that you have created and any software that you have installed
on the computer are permanently removed. When reformatting is complete, the recovery process helps
you restore the operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows 7 operating system DVD:
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E/?’NOTE: This process takes several minutes.

1.
2,

3
q
5.
6
7

If possible, back up all personal files.

Restart the computer, and then insert the Windows 7 operating system DVD into the optical drive
before the Windows operating system loads.

[ NOTE: It the computer does not boot to the DVD, restart the computer and press Esc as the

computer is powering on to see the startup menu. Use the arrow keys to select the boot menu and
press Enter. Use the arrow keys to select the location where the recovery DVD is inserted. Press
Enter to boot from that device.

When prompted, press any keyboard key.
Follow the on-screen instructions.

Click Next.

Select Install now.

Follow the on-screen instructions.

After the repair is completed:

1.
2,

Eject the Windows 7 operating system DVD and then insert the Driver Recovery DVD.

Follow the on-screen instructions to install the Hardware Enabling Drivers first, and then install
Recommended Applications.
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Statement of Volatility

HP confirms that Intel-based HP 406 G1 MT personal computer contains DDR RAM volatile memory
(memory amount depends on the customer configuration). In addition, the motherboard in the condition
originally shipped without subsequent modification or the addition or installation of any applications,
features, or functionality, contain the following non-volatile memory: PCH Real Time Clock (RTC) battery
backed-up configuration memory (256 Bytes), DIMM Serial Presence Detect (SPD) configuration data
(256 Bytes per module, 128 Bytes programmable), and Serial Flash IC for System BIOS (64M Bits).

The volatile memory is cleared by removing power from the system for greater than 30 seconds. The
non-volatile memory on the motherboard is restored by following the steps below:

1. Download the latest BIOS for this system and operating system off of the HP website.
2. Follow the instructions on the website to flash the BIOS.

3. Enfer F10 setup.
4

Select Default Setup > Reset Factory Settings as Default, and then select Apply
Defaults and Exit. Setup and Power-on password can be cleared by the BIOS Password Clear
jumper.

5. Power down the system and remove the AC power card. The RTC and Super /O battery backed-
up memory is cleared by removing the battery found on the motherboard, allowing the board to
sit for greater than 60 seconds, and then replacing the battery.

The DIMM SPD EEPROM is not readily available to the user, however there are tools publicly available
to read and write this part. To eliminate the possibility that it could contain sensitive information,
remove the DIMMs or use one of these tools.
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I Specifications

MT Specifications

Table I-1 Specifications

Chassis

Height 14.05 in 357 mm

Width 7.2in 182.88 mm

Depth 15.82 in 402mm

Approximate Weight 15.75 b 7.148 kg

Temperature Range

Operating 50° to 95°F 10° to 35°C

Nonoperating -22° to 140°F -30° to 60°C

Relative Humidity (noncondensing)

Operating 10-90% 10-90%

Non-operating 595% 595%

Maximum Altitude (unpressurized)

Operating 10,000 ft 3048 m
30,000 ft 9144 m

Nonoperating

Power Supply

Standard Efficiency

High Efficiency

Operating Voltage Range

Rated Line Frequency

Operating Line Frequency Range
Rated Input Current

Rated Voltage Range

300W active PFC

300W active PFC EStar 6

90 - 264 VAC

50/60 Hz
47 - 63 Hz

4A

200-240 VAC (300W active PFC)

134 Appendix | Specifications



Index

A
access panel
locked 85
removal and replacement 24
spare part number 10, 13, 24
audible codes 76
audio problems 99
audio, product description 1

B
backup and recovery, Windows
7 125
Backup and Restore, Windows 7
128
backups
creating Windows 7 125,
128
beep codes 76
booting options
Full Boot 68
Quick Boot 68

C
cable connections 30
cable management 22, 29
cable pinouts, SATA data 21
cautions
AC power 14
cables 20
cooling fan 19
electrostatic discharge 14
keyboard cleaning 19
keyboard keys 19
CD-ROM or DVD problems 113
chasis types, illustrated 14
chipset, product description 1
cleaning
computer 18

mouse 19

safety precautions 18
CMOS

backing up 77

clearing and resetting 79
computer cleaning 18
connecting drive cables 35
connections

system board 30
country power cord set

requirements 67

Customer Support 81

D
disassembly preparation 23
drive connectors 36
Driver Recovery DVD,
creating 127
using for restore 131
Driver Recovery media,
Windows 124
Driver Recovery media, Windows
8.1 124

drives
connecting cables 35
installing 35

removal and replacement 34

E
electrostatic discharge (ESD) 14
preventing damage 15
error
codes 68, 76
messages 69
expansion card
microtower installation 31
microtower removal 31

F
f11 recovery, Windows 8 123
f11 recovery, Windows 8.1 123
fan sink
removal and replacement 49
spare part number 11, 49
fan, power supply 19
fan, system
removal and replacement 44
spare part number 11, 12, 44
flash drive problems 115
flashing LEDs 76
foot, spare part number
front bezel
removal and replacement 25
spare part number 10, 25
front bezel,
spare part number 13
front components 4
front 1/O and USB assembly
removal 39
spare part number 11, 13, 39
front panel problems 116

11,12

G

general problems 84
graphics, product description 1
grounding methods 16

H
hard drive
product description 1
proper handling 20
removing 38
SATA characteristics 21
spare part numbers 10
hard drive problems 89
hard drive recovery
Windows 123

Index 135



Windows 7 129
Windows 8.1 123
hardware installation problems
104
heat sink
removal and replacement 49
Help and Support
Windows 7 125
helpful hints 82
HP Recovery Disc Creator, using
127

1
installing

drive cables 35

microtower expansion card 31
Internet access problems 116

K
keyboard
cleaning 18
product description 2
keyboard problems 102
keyboards
spare part number 11

M

media card reader
problems 92

memory

populating sockets 27

problems 110

removal and replacement 26

specifications 26
memory module

product description 1
memory modules

spare part number 10
model name 1
monitor problems 93
mouse

cleaning 19

problems 102

spare part number 11

N
network problems 107
numeric error codes 69

(o]
operating guidelines 17

136  Index

operating system media, Windows
8 124
operating system media, Windows
8.1 124
operating system, product
description 3
optical drive
problems 113
removing 37
spare part numbers 10, 12
optical drive, product description
1

overheating, prevention 17

P

password
clearing 77
power-on 77
setup 77

pointing device, product
description 2
ports
product description 2
POST error messages 68
power cord set requirements
country specific 67
power problems 88
power requirements, product
description 2
power supply
fan 19
operating voltage range 134
removal and replacement 52
spare part number 10
power switch/LED
removal and replacement 41
power switch/LED assembly
spare part number 12, 13, 41
power-on password 77
preparation for disassembly 23
printer problems 101
problems
audio 99
CD-ROM or DVD 113
flash drive 115
front panel 116
general 84
hard drive 89
hardware installation 104
Internet access 116

keyboard 102

Media Card Reader 92

memory 110

monitor 93

mouse 102

network 107

power 88

printer 101

processor 112

software 118
processor

product description 1

removal and replacement 46,

51

spare part number 10
processor problems 112
product description

audio 1

chipset 1

ethernet 2

graphics 1

hard drive 1

keyboard 2

memory module 1

operating system 3

optical drive 1

pointing device 2

ports 2

power requirements 2

processors 1

product name 1

serviceability 3
product name 1

R

rear components 5

recovery discs, steps for creating
Windows 7 126

recovery discs, using for restore
131

recovery media, creating 127

recovery media, creating Windows
7 125

recovery partition, Windows 8
123

recovery partition, Windows 8.1
123

recovery USB flash drive, steps for
creating Windows 7 126



recovery using Windows 8
operating system media 124
recovery using Windows 8.1
operating system media 124
removal and replacement
access panel 24
drives 34
fan sink 49
fan, system 44
front bezel 25
heat sink 49
memory 26
power supply 52
power switch 41

processor 46, 51

speaker 46

system board 55
removing

hard drive 38
microtower expansion card 31
optical drive 37
resetting
CMOS 77
password jumper 77
restoring the hard drive,
Windows 123
restoring the hard drive, Windows
8.1 123

S
safety and comfort 81
safety precautions
cleaning 18
SATA
connectors on system board
21
data cable pinouts 21
hard drive characteristics 21
screws, correct size 20
SDRAM (synchronous dynamic
random access memory 26
service considerations 19
serviceability features 23
serviceability, product description
3
setup password 77
software
problems 118

servicing computer 20

spare part number
tamper-resistant wrench 20
Torx T-15 screwdriver 20
speaker
removal and replacement 46
spare part number 11, 13, 46
specifications
computer 134
memory 26
Statement of Volatility (SOV) 133
static electricity 15
system board
removal and replacement 55
SATA connectors 21
spare part number 10, 55
system board drive connections
36
system board,
spare part number 13
System Recovery using Windows 7
recovery media
130
System Recovery, Windows 7
129
system restore points, creating
Windows 7 125
System Restore, Windows 7 128

T
tamper-proof screws

tool 20
temperature control 17

tools, servicing 20
Torx T15 screwdriver 20

\"
ventilation, proper 17

w

Wake-on-LAN feature 107

Windows 7
backing up information 128
backup and recovery 125
Backup and Restore 128
creating backups 125
creating recovery media 125
creating system restore points

125

hard drive recovery 129
Help and Support 125

steps for creating recovery
discs 126
steps for creating recovery
media 126
steps for creating recovery USB
flash drive 126
System Recovery 129
System Recovery using recovery
media 130
System Restore 128
Windows 7 operating system discs
using for restore 131
Windows 7 operating system DVD
creating 127
using for restore 131
Windows 7 operating system
media
creating 127
Windows 8
backup and restore 122
Driver Recovery media 124
f11 recovery 123
hard drive recovery 123
operating system DVD 124
recovery partition 123
restoring the hard drive 123
Windows 8.1
backup and restore 122
Driver Recovery media 124
f11 recovery 123
hard drive recovery 123
operating system DVD 124
recovery partition 123
restoring the hard drive 123

Index 137



	Product description
	Product features
	Front components
	Rear components

	Activating and Customizing the Software
	Activating and customizing the software in Windows 7
	Activating the Windows operating system
	Downloading Windows 7 updates
	Installing or upgrading device drivers
	Customizing the monitor display

	Activating and customizing the software in Windows 8
	Activating the Windows Operating System
	Downloading Windows 8 updates
	Customizing the monitor display


	Illustrated parts catalog
	Computer Major Components
	Drives
	Misc Parts
	Cables
	Sequential Part Number Listing

	Routine care, SATA drive guidelines, and disassembly preparation
	Electrostatic discharge information
	Generating static
	Preventing electrostatic damage to equipment
	Personal grounding methods and equipment
	Grounding the work area
	Recommended materials and equipment

	Operating guidelines
	Routine care
	General cleaning safety precautions
	Cleaning the Computer Case
	Cleaning the keyboard
	Cleaning the monitor
	Cleaning the mouse

	Service considerations
	Power supply fan
	Tools and software Requirements
	Screws
	Cables and connectors
	Hard Drives

	SATA hard drives
	SATA hard drive cables
	SATA data cable

	SMART ATA drives
	Cable management

	Removal and replacement procedures
	Serviceability features
	Preparation for disassembly
	Access panel
	Front bezel
	Memory
	DDR3/DDR3L-SDRAM UDIMMs or SODIMMs
	Populating DIMM sockets
	Removing memory modules

	Cable management
	Cable connections

	Expansion cards
	Drives
	Installing additional drives
	System board drive connections
	Removing an optical drive
	Removing a hard drive


	Front I/O and USB panel housing assembly
	Power switch/LED assembly
	System fan
	Speaker
	Fan sink assembly
	Processor
	Power supply
	System board

	Computer Setup (F10) Utility
	Computer Setup (F10) Utilities
	Using Computer Setup (F10) Utilities
	Computer Setup—File
	Computer Setup—Storage
	Computer Setup—Security
	Computer Setup—Power
	Computer Setup—Advanced


	Power cord set requirements
	General requirements
	Japanese power cord requirements
	Country-specific requirements

	POST Error Messages
	POST Numeric Codes and Text Messages
	Interpreting POST Diagnostic Front Panel LEDs and Audible Codes

	Password Security and Resetting CMOS
	Resetting the Password Jumper
	Clearing and Resetting the CMOS

	Troubleshooting without diagnostics
	Safety and comfort
	Before you call for technical support
	Helpful hints
	Solving general problems
	Solving power problems
	Solving hard drive problems
	Solving media card reader problems
	Solving display problems
	Solving audio problems
	Solving printer problems
	Solving keyboard and mouse problems
	Solving Hardware Installation Problems
	Solving Network Problems
	Solving memory problems
	Solving processor problems
	Solving CD-ROM and DVD problems
	Solving USB flash drive problems
	Solving front panel component problems
	Solving Internet access problems
	Solving software problems

	HP PC Hardware Diagnostics
	Why run HP PC Hardware Diagnostics
	How to access and run HP PC Hardware Diagnostics
	Downloading HP PC Hardware Diagnostics to a USB device

	System backup and recovery
	Backing up, restoring, and recovering in Windows 8.1 or Windows 8
	Creating recovery media and backups
	Restoring and recovering using Windows tools
	Using Reset when the system is not responding
	Recovery using the Windows recovery USB flash drive
	Recovery using Windows operating system media (purchased separately)


	Backing up, restoring, and recovering in Windows 7
	Creating recovery media
	Creating recovery media using HP Recovery Manager (select models only)
	Creating recovery discs with HP Recovery Disc Creator (select models only)
	Creating recovery discs

	Backing up your information

	System Restore
	System Recovery
	System Recovery when Windows is responding
	System Recovery when Windows is not responding
	System Recovery using recovery media (select models only)
	Using HP Recovery Disc operating system discs (select models only)



	Statement of Volatility
	Specifications
	MT Specifications

	Index


<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /None
  /Binding /Left
  /CalGrayProfile (Gray Gamma 2.2)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Error
  /CompatibilityLevel 1.5
  /CompressObjects /All
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.1000
  /ColorConversionStrategy /sRGB
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 524288
  /LockDistillerParams true
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings false
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Remove
  /UCRandBGInfo /Remove
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
    /Courier
    /Courier-Bold
    /Courier-BoldOblique
    /Courier-Oblique
    /Helvetica
    /Helvetica-Bold
    /Helvetica-BoldOblique
    /Helvetica-Oblique
    /Symbol
    /Times-Bold
    /Times-BoldItalic
    /Times-Italic
    /Times-Roman
    /ZapfDingbats
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 150
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 150
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /ColorImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 150
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 150
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /GrayImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 600
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.33333
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects true
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile (None)
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName (http://www.color.org)
  /PDFXTrapped /False

  /CreateJDFFile false
  /SyntheticBoldness 1.000000
  /Description <<
    /ENU (FOR Acrobat 9 HPIE Screen Optimized PDF compatible with Sceenshots under 225 dpi)
  >>
>> setdistillerparams
<<
  /HWResolution [600 600]
  /PageSize [612.000 792.000]
>> setpagedevice


